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ȷɜŰɑ ˊɟɞɚɧɔɞɡ 
 

ȼ ŭɖɛɘɞɡɟɔɑŬ ɛɘŬɠ ɘůŰɞůŮɚɑŭŬɠ ŮɑɜŬɘ Ůɨəɞɚɖ. ȼ ŭɖɛɘɞɡɟɔɑŬ ɛɘŬɠ ŮˊɘŰɡɢɖɛɏɜɖɠ 

ɘůŰɞůŮɚɑŭŬɠ ŮɑɜŬɘ ɛɘŬ ŭɘŬŭɟŬůŰɘəɐ ŭɘŬůɨɜŭŮůɖ, ɛɘŬ ˊɟɧəɚɖůɖ ɔɘŬ Űɞ əɞɘɜɧ əŬɘ Űɞ 

ŬəɟɞŬŰɐɟɘɞ ůŰɞ ɞˊɞɑɞ ŬˊŮɡɗɨɜŮŰŬɘ.  

ɇɞ Internet ɛŮ Űɘɠ ŰɟɏɢɞɡůŮɠ əŬɘ ŬɜŬŭɡɧɛŮɜŮɠ ŭɡɜŬŰɧŰɖŰŮɠ Űɤɜ ˊɞɚɡɛɏůɤɜ 

ˊɞɡ ˊŬɟɏɢŮɘ, ˊɟɞůűɏɟŮɘ ɎűɗɞɜŮɠ ŮɡəŬɘɟɑŮɠ əŬɘ ŮɑɜŬɘ ɘŭɘŬɑŰŮɟŬ ɢɟɐůɘɛɞ. Ƀɘ ůɨɔɢɟɞɜŮɠ 

ŮŰŬɘɟŮɑŮɠ ɔɘŬ ɜŬ ŬˊɞəŰɐůɞɡɜ ɏɜŬ ŬɜŰŬɔɤɜɘůŰɘəɧ ˊɚŮɞɜɏəŰɖɛŬ ůŰɖɜ ŬɔɞɟɎ, 

ŮəɛŮŰŬɚɚŮɨɞɜŰŬɘ ůŰɞ ɏˊŬəɟɞ Űɞ ˊɚɖɟɞűɞɟɘŬəɧ əŬɘ ůɡɜŬɚɚŬəŰɘəɧ ŭɡɜŬɛɘəɧ Űɞɡ 

ȹɘŬŭɘəŰɨɞɡ.  

ȼ ́ŬɟɞɨůŬ ŮɟɔŬůɑŬ ˊŮɟɘɔɟɎűŮɘ ɧɚŬ ŰŬ ůŰɎŭɘŬ əŬŰŬůəŮɡɐɠ ɛɘŬɠ ɘůŰɞůŮɚɑŭŬɠ, 

ŰŬ ɢŬɟŬəŰɖɟɘůŰɘəɎ Űɖɠ, Űɞɜ ůɢŮŭɘŬůɛɧ Űɖɠ, Űɖ ŭɘŬŭɟŬůŰɘəɧŰɖŰŬ, Űɖɜ ˊɚɞɐɔɖůɖ, Űɖ 

ɚŮɘŰɞɡɟɔɘəɧŰɖŰŬ, ɛŮ ůəɞˊɧ Űɖɜ Ŭɝɘɞˊɞɑɖůɖ Űɞɡ ˊɚɐɟŮɠ ŭɡɜŬɛɘəɞɨ Űɞɡ ȹɘŬŭɘəŰɨɞɡ.  

ũɘŬ Űɖɜ əŬŰŬůəŮɡɐ Űɖɠ ɘůŰɞůŮɚɑŭŬɠ ɢɟɖůɘɛɞˊɞɘɐɗɖəŮ ɏɜŬ ůɨɔɢɟɞɜɞ, 

ŭɖɛɞűɘɚɏɠ ůɨůŰɖɛŬ ŭɘŬɢŮɑɟɘůɖɠ ˊŮɟɘŮɢɞɛɏɜɞɡ Űɞ Joomla, Űɞ ɞˊɞɑɞ ˊɟɞůűɏɟŮŰŬɘ 

ůɐɛŮɟŬ ŭɤɟŮɎɜ.  

ɆŰɖɜ ˊɞɟŮɑŬ Ůəˊɧɜɖůɖɠ ŬɡŰɐɠ Űɖɠ ŮɟɔŬůɑŬɠ, ɡˊɐɟɝŬɜ ˊɞɚɚɎ ˊɟɧůɤˊŬ, ˊɞɡ ɖ 

ůɡɛɓɞɚɐ əŬɘ ɖ ɓɞɐɗŮɘɎ Űɞɡɠ, ɡˊɐɟɝŮ əŬɗɞɟɘůŰɘəɐ. ŪŬ ɐɗŮɚŬ ŮɘɚɘəɟɘɜɎ ɜŬ 

ŮɡɢŬɟɘůŰɐůɤ, Űɞɜ ŮˊɘɓɚɏˊɞɜŰŬ əŬɗɖɔɖŰɐ ɛɞɡ ə. ȾɩůŰŬ ȾɞɡəɞɡɚɏŰůɞ, ɔɘŬ Űɖɜ 

ŮɜɗɎɟɟɡɜůɖ, Űɖɜ ɡˊɞůŰɐɟɘɝɖ əŬɘ Űɖɜ  ŮɛˊɜŮɡůɛɏɜɖ əŬɗɞŭɐɔɖůɐ Űɞɡ. Ƀɘ əŬɑɟɘŮɠ 

ˊŬɟŬŰɖɟɐůŮɘɠ Űɞɡ, ɞɘ ɞŭɖɔɑŮɠ əŬɘ ɞɘ ˊŬɟɞŰɟɨɜůŮɘɠ Űɞɡ, ɛŮ ŭɘŮɡəɧɚɡɜŬɜ ɜŬ 

ˊɟɞůŮɔɔɑůɤ Űɞ ɗɏɛŬ ɛŮ ɛɘŬ ŭɘŬűɞɟŮŰɘəɐ ɞˊŰɘəɐ əŬɘ Űɞɜ ŮɡɢŬɟɘůŰɩ ɗŮɟɛɎ ɔɘô ŬɡŰɧ. ɇɞ 

ɘŭɘŬɑŰŮɟɞ ŮɜŭɘŬűɏɟɞɜ Űɞɡ, ɖ ŭɘɎɗŮůɐ Űɞɡ ɔɘŬ ŮˊɘəɞɘɜɤɜɑŬ əŬɘ ɖ ŮˊɘůŰɖɛɞɜɘəɐ Űɞɡ 

ɔɜɩůɖ, ŬˊɞŰɏɚŮůŮ ˊɖɔɐ ɏɛˊɜŮɡůɖɠ ɔɘŬ ɧɚɞɡɠ Űɞɡɠ űɞɘŰɖŰɏɠ əŬɘ ɔɘŬ ɛɏɜŬ ˊɟɞůɤˊɘəɎ. 

ɄɞɚɨŰɘɛɖ ɐŰŬɜ ɖ ɓɞɐɗŮɘŬ Űɖɠ ŬŭŮɟűɐ ɛɞɡ Ⱥɘɟɐɜɖɠ, ˊŰɡɢɘɞɨɢɞ ɀŬɗɖɛŬŰɘəɧ 

Űɞɡ ɄŬɜŮˊɘůŰɖɛɑɞɡ ȷɗɖɜɩɜ, ɖ ɞˊɞɑŬ ɛŮ ɛŮɔɎɚɖ ˊɟɞɗɡɛɑŬ əŬɘ əŬŰŬɜɧɖůɖ, ɛɏůŬ Ŭˊɧ 

ŭɘŮɝɞŭɘəɏɠ ůɡɕɖŰɐůŮɘɠ, ůɡɜɏɓŬɚŮ əŬɘ ɡˊɞůŰɐɟɘɝŮ ɛŮ Űɞɜ ŭɘəɧ Űɖɠ Űɟɧˊɞ, Űɖɜ ɧɚɖ ɛɞɡ 
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ˊɟɞůˊɎɗŮɘŬ. ȼ ůɡɜŮɢɐɠ ˊɟɞŰɟɞˊɐ əŬɘ ŮɜɗɎɟɟɡɜůɐ Űɖɠ, ůŮ ˊŮɟɘɧŭɞɡɠ ɛŮɔɎɚɖɠ 

əɧˊɤůɖɠ əŬɘ ɛŮɑɤůɖɠ Űɤɜ ŭɡɜɎɛŮɩɜ ɛɞɡ ɐŰŬɜ ˊɞɚɨ ůɖɛŬɜŰɘəɐ ɔɘŬ ɛɏɜŬ.  

ɇɏɚɞɠ ɗŬ ɐɗŮɚŬ ɜŬ ŮɡɢŬɟɘůŰɐůɤ ɘŭɘŬɑŰŮɟŬ Űɞɡɠ ɔɞɜŮɑɠ ɛɞɡ, ɔɘŬ Űɖɜ ˊɞɚɨŰɘɛɖ 

ɓɞɐɗŮɘɎ Űɞɡɠ əŬɘ əɡɟɑɤɠ ɔɘŬ Űɖɜ ŮɛˊɘůŰɞůɨɜɖ ˊɞɡ ɛɞɡ ɏŭŮɘɝŬɜ.  ȼ ůɡɛɓɞɚɐ Űɞɡɠ 

ɐŰŬɜ əŬɗɞɟɘůŰɘəɐɠ ůɖɛŬůɑŬɠ ůŰɖɜ ˊɞɟŮɑŬ əŬɘ Ůɝɏɚɘɝɖ Űɖɠ ˊŬɟɞɨůŬɠ ŮɟɔŬůɑŬɠ. 
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ȺɘůŬɔɤɔɐ 

Ɇəɞˊɧɠ Űɖɠ ˊŬɟɞɨůŬɠ ˊŰɡɢɘŬəɐɠ ŮɟɔŬůɑŬɠ ŮɑɜŬɘ ɖ ŭɖɛɘɞɡɟɔɑŬ ɘůŰɞůŮɚɑŭŬɠ 

ɝŮɜɞŭɞɢŮɘŬəɐɠ ɛɞɜɎŭŬɠ. ȼ əŬŰŬůəŮɡɐ Űɖɠ ɏɔɘɜŮ ɢɟɖůɘɛɞˊɞɘɩɜŰŬɠ ɏɜŬ Ŭˊɧ ŰŬ ˊɘɞ 

ŭɖɛɞűɘɚɐ CMS (Content Management System) ůŰɞɜ əɧůɛɞ Űɞ Joomla. ɄɟɞűŬɜɩɠ 

ɡˊɎɟɢɞɡɜ əŬɘ ɎɚɚŬ CMS, (ɧˊɤɠ ˊ.ɢ Űɞ WordPress, Drupal ə.Ŭ.), ŬɚɚɎ ŮˊɘɚɏɝŬɛŮ Űɞ 

Joomla ɔɘŬŰɑ ŬűŮɜɧɠ ŮɑɜŬɘ ɛɑŬ ŭɤɟŮɎɜ ŮűŬɟɛɞɔɐ, ŬɜɞɘɢŰɞɨ əɩŭɘəŬ ůɨůŰɖɛŬ 

ŭɘŬɢŮɑɟɘůɖɠ ˊŮɟɘŮɢɞɛɏɜɞɡ, Űɞ ɞˊɞɑɞ ɢɟɖůɘɛɞˊɞɘŮɑ ůŬɜ ɔɚɩůůŬ ˊɟɞɔɟŬɛɛŬŰɘůɛɞɨ Űɖɜ 

PHP ɔɘŬ Űɖ ŭɘŬɢŮɑɟɘůɖ əŬɘ Űɖ ŭɖɛɞůɑŮɡůɖ ˊŮɟɘŮɢɞɛɏɜɞɡ ůŰɞɜ ɘůŰɧ (web), ůɡɜŭɏŮŰŬɘ 

ŮɨəɞɚŬ ɛŮ ɛɘŬ ɓɎůɖ ŭŮŭɞɛɏɜɤɜ Űɖɜ MySQL əŬɘ ŬűŮŰɏɟɞɡ ɡˊɎɟɢŮɘ ˊɚɖɗɩɟŬ 

ŭɘŬɗɏůɘɛɤɜ Templates ŭɤɟŮɎɜ ŬɚɚɎ əŬɘ ŮɛˊɞɟɘəɎ, əŬɗɩɠ əŬɘ ɏŰɞɘɛŬ ɀodules, 

Plugins əŬɘ Components ŭɤɟŮɎɜ əŬɘ ŮɛˊɞɟɘəɎ ŰŬ ɞˊɞɑŬ ŭɘŮɡəɞɚɨɜɞɡɜ ůŰɖɜ 

ŭɘŬɛɧɟűɤůɖ ŮˊɘɗɡɛɖŰɐɠ ɘůŰɞůŮɚɑŭŬɠ. Ⱥˊɑůɖɠ ŮɑɜŬɘ űɘɚɘəɧ ˊɟɞɠ Űɞ ɢɟɐůŰɖ əŬɘ ŮɨəɞɚŬ 

ɛŮŰŬŰɟɏˊŮŰŬɘ ɖ ɘůŰɞůŮɚɑŭŬ ůŮ ˊɞɚɡɔɚɤůůɘəɐ. 

ɀˊɞɟɞɨɛŮ ɜŬ Űɞ əŬŰŮɓɎůɞɡɛŮ Ŭˊɧ Űɖɜ ɘůŰɞůŮɚɑŭŬ Űɞɡ Joomla (1), ɧˊɤɠ əŬɘ Ŭˊɧ 

Űɖɜ ɘůŰɞůŮɚɑŭŬ Joomla (2). 
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ȾȺūȷȿȷȽɃ 1 

1.1.       WAMP Server 
 

ɂŮəɘɜɐůŬɛŮ Űɖɜ ŮɟɔŬůɑŬ ɛŬɠ ŮɔəŬɗɘůŰɩɜŰŬɠ ůŰɞɜ ɡˊɞɚɞɔɘůŰɐ ɛŬɠ Űɞɜ WAMP 

Server. Ƀ WAMP Server ŮɑɜŬɘ ɚɞɔɘůɛɘəɧ ŬɜɞɘɢŰɞɨ əɩŭɘəŬ ˊɞɡ ɛŬɠ ŭɑɜŮɘ Űɖɜ 

ŭɡɜŬŰɧŰɖŰŬ ɜŬ əɎɜɞɡɛŮ Űɞɜ ɡˊɞɚɞɔɘůŰɐ ɛŬɠ Web Server. ȷɜŬűɏɟŮŰŬɘ ůŮ ɏɜŬ ůɨɜɞɚɞ 

ˊɟɞɔɟŬɛɛɎŰɤɜ ɔɘŬ Űɞ ɚŮɘŰɞɡɟɔɘəɧ ůɨůŰɖɛŬ Microsoft Windows, ˊɞɡ ŭɖɛɘɞɡɟɔɐɗɖəŮ 

Ŭˊɧ Űɞɜ Romain Bourdon əŬɘ ŬˊɞŰŮɚŮɑŰŬɘ Ŭˊɧ Űɞɜ Web Server Apache, Űɖ ɓɎůɖ 

ŭŮŭɞɛɏɜɤɜ MySQL əŬɘ Űɖɜ ɔɚɩůůŬ ˊɟɞɔɟŬɛɛŬŰɘůɛɞɨ PHP. ɇɞ ɧɜɞɛŬ WAMP 

ŬˊɞŰŮɚŮɑŰŬɘ Ŭˊɧ ŰŬ ŬɟɢɘəɎ: 

Å W:  Windows.  ȷɡŰɧ ůɖɛŬɑɜŮɘ ɧŰɘ ɞ Server ŬɡŰɧɠ ɚŮɘŰɞɡɟɔŮɑ ɛɧɜɞ ůŮ ɚŮɘŰɞɡɟɔɘəɧ 

ɆɨůŰɖɛŬ windows. 

Å A:  Apache.  ȹɖɚŬŭɐ ɞ Web Server ŮɑɜŬɘ ɞ Apache. 

Å M:  MySQL. ɉɟɖůɘɛɞˊɞɘŮɑ Űɖɜ ɓɎůɖ ŭŮŭɞɛɏɜɤɜ MySQL . 

Å  P: PHP. ȺɑɜŬɘ ɛɑŬ ɔɚɩůůŬ ˊɟɞɔɟŬɛɛŬŰɘůɛɞɨ ɔɘŬ Űɖ ŭɖɛɘɞɡɟɔɑŬ ŭɡɜŬɛɘəɩɜ 

ɘůŰɞůŮɚɑŭɤɜ.    

1.2.       Apache HTTP ŮɝɡˊɖɟŮŰɖŰɐɠ 
 

Ƀ Apache HTTP ŮɑɜŬɘ ɏɜŬɠ ŮɝɡˊɖɟŮŰɖŰɐɠ Űɞɡ ˊŬɔəɧůɛɘɞɡ ɘůŰɞɨ (web). ȳŰŬɜ 

ɏɜŬɠ ɢɟɐůŰɖɠ ŮˊɘůəɏˊŰŮŰŬɘ ɛɑŬ ɘůŰɞůŮɚɑŭŬ, ɞ Web Browser ŮˊɘəɞɘɜɤɜŮɑ ɛŮ ɏɜŬɜ 

ŭɘŬəɞɛɘůŰɐ (Server) ɛɏůɤ Űɞɡ ˊɟɤŰɞəɧɚɚɞɡ HTTP, ɞ ɞˊɞɑɞɠ ˊŬɟɎɔŮɘ Űɘɠ ɘůŰɞůŮɚɑŭŮɠ 

əŬɘ Űɘɠ ůŰɏɚɜŮɘ ůŰɞ ɢɟɐůŰɖ ɛŮ ŬˊɞŰɏɚŮůɛŬ ɜŬ Űɘɠ ŭŮɘ ůŰɖɜ ɞɗɧɜɖ Űɞɡ. O Apache ŮɑɜŬɘ 

ɏɜŬɠ Ŭˊɧ Űɞɡɠ ŭɖɛɞűɘɚɏůŰŮɟɞɡɠ ŮɝɡˊɖɟŮŰɖŰɏɠ ɘůŰɞɨ, ɔɘŬŰɑ ɚŮɘŰɞɡɟɔŮɑ ůŮ ŭɘɎűɞɟŬ 

ɚŮɘŰɞɡɟɔɘəɎ ůɡůŰɐɛŬŰŬ ɧˊɤɠ Űɞ Windows, Űɞ Linux, Űɞ Unix əŬɘ Űɞ MacOSx. 

ȾɡəɚɞűɧɟɖůŮ ɡˊɧ Űɖɜ ɎŭŮɘŬ ɚɞɔɘůɛɘəɞɨ Apache əŬɘ ŮɑɜŬɘ ˊɟɧɔɟŬɛɛŬ ŬɜɞɘɢŰɞɨ 

əɩŭɘəŬ. ɆɡɜŰɖɟŮɑŰŬɘ Ŭˊɧ ɛɘŬ əɞɘɜɧŰɖŰŬ ŬɜɞɘəŰɞɨ əɩŭɘəŬ ɛŮ ŮˊɘŰɐɟɖůɖ Ŭˊɧ Űɞ 

ȲŭɟɡɛŬ ȿɞɔɘůɛɘəɞɨ Apache (Apache Software Foundation). 

Ƀ Apache ɢɟɖůɘɛɞˊɞɘŮɑŰŬɘ əŬɘ ůŮ ŰɞˊɘəɎ ŭɑəŰɡŬ ůŬɜ Web Server 

ůɡɜŮɟɔŬɕɧɛŮɜɞɠ ɛŮ ůɡůŰɐɛŬŰŬ ŭɘŬɢŮɑɟɘůɖɠ ȸɎůɖɠ ȹŮŭɞɛɏɜɤɜ ˊ.ɢ. Oracle, MySQL. 
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1.3.       MySQL 
 

ȼ MYSQL ŮɑɜŬɘ ɏɜŬ ůɨůŰɖɛŬ ŭɘŬɢŮɑɟɘůɖɠ ɓɎůŮɤɜ ŭŮŭɞɛɏɜɤɜ ˊɞɡ ɛŮŰɟɎ 

ˊŮɟɘůůɧŰŮɟŮɠ Ŭˊɧ 11 ŮəŬŰɞɛɛɨɟɘŬ ŮɔəŬŰŬůŰɎůŮɘɠ. ȰɚŬɓŮ Űɞ ɧɜɞɛɎ Űɖɠ Ŭˊɧ Űɖɜ əɧɟɖ 

Űɞɡ ɀɧɜŰɡ ȸɘɜŰɏɜɘɞɡɠ, Űɖ ɀɎɘ (My). ɇɞ ˊɟɧɔɟŬɛɛŬ ŰɟɏɢŮɘ ɏɜŬɜ ŮɝɡˊɖɟŮŰɖŰɐ 

(Server) ˊŬɟɏɢɞɜŰŬɠ ˊɟɧůɓŬůɖ ˊɞɚɚɩɜ ɢɟɖůŰɩɜ ůŮ ɏɜŬ ůɨɜɞɚɞ ɓɎůŮɤɜ ŭŮŭɞɛɏɜɤɜ. 

ȼ MySQL ŮɑɜŬɘ ɛɑŬ ŭɖɛɞűɘɚɐɠ ɓɎůɖ ŭŮŭɞɛɏɜɤɜ ɔɘŬ ŭɘŬŭɘəŰɡŬəɏɠ ŮűŬɟɛɞɔɏɠ əŬɘ 

ɘůŰɞůŮɚɑŭŮɠ. ɉɟɖůɘɛɞˊɞɘŮɑŰŬɘ Ŭˊɧ Űɘɠ ˊɘɞ ŭɘŬŭŮŭɞɛɏɜŮɠ ŭɘŬŭɘəŰɡŬəɏɠ ɡˊɖɟŮůɑŮɠ, ɧˊɤɠ 

Űɞ Youtube, Wikipedia, Google, Facebook əŬɘ Twitter. 

1.4.       PHP 
 

PHP (Hypertext Preprocessor) ŮɑɜŬɘ ɛɘŬ ɔɚɩůůŬ ˊɟɞɔɟŬɛɛŬŰɘůɛɞɨ ɔɘŬ Űɖ 

ŭɖɛɘɞɡɟɔɑŬ ŭɡɜŬɛɘəɩɜ ɘůŰɞůŮɚɑŭɤɜ. ɀɘŬ ůŮɚɑŭŬ PHP ˊŮɟɜɎ Ŭˊɧ ŮˊŮɝŮɟɔŬůɑŬ Ŭˊɧ 

ɏɜŬ ůɡɛɓŬŰɧ web Server (ůɡɜɐɗɤɠ ɞ Apache), ɩůŰŮ ɜŬ ˊŬɟŬɢɗŮɑ ůŮ ɚɑɔŬ 

ŭŮɡŰŮɟɧɚŮˊŰŬ Űɞ ŰŮɚɘəɧ ˊŮɟɘŮɢɧɛŮɜɞ Űɖɠ ůŮɚɑŭŬɠ, ˊɞɡ ŮɑŰŮ ɗŬ ůŰŬɚŮɑ ůŰɞ ˊɟɧɔɟŬɛɛŬ 

űɡɚɚɞɛŮŰɟɖŰɐ ɘůŰɞɨ Űɤɜ ŮˊɘůəŮˊŰɩɜ ůŮ ɛɞɟűɐ əɩŭɘəŬ HTML ɐ ɗŬ ŮˊŮɝŮɟɔŬůŰŮɑ Űɘɠ 

Ůɘůɧŭɞɡɠ ŭɑɢɤɠ ɜŬ ˊɟɞɓɎɚɚŮɘ Űɖɜ ɏɝɞŭɞ ůŰɞ ɢɟɐůŰɖ, ŬɚɚɎ ɗŬ Űɘɠ ɛŮŰŬɓɘɓɎůŮɘ ůŮ 

əɎˊɞɘɞ Ɏɚɚɞ PHP script. ȼ PHP ŬˊɞŰŮɚŮɑ ɛɘŬ Ŭˊɧ Űɘɠ ˊɘɞ ŭɘŬŭŮŭɞɛɏɜŮɠ ŰŮɢɜɞɚɞɔɑŮɠ 

ůŰɞ ɄŬɔəɧůɛɘɞ ȽůŰɧ, əŬɗɩɠ ɢɟɖůɘɛɞˊɞɘŮɑŰŬɘ Ŭˊɧ ˊɞɚɚɏɠ ŮűŬɟɛɞɔɏɠ əŬɘ ɘůŰɞůŮɚɑŭŮɠ. 

ɉɟɖůɘɛɞˊɞɘŮɑŰŮ ŰŬəŰɘəɎ əŬɘ ŮɑɜŬɘ Ůɨəɞɚɖ ůŰɖɜ ɢɟɐůɖ ˊɟɞɔɟŬɛɛŬŰɘůɛɞɨ ŬɚɚɎ əŬɘ 

ůŰɞ ɔŮɔɞɜɧɠ ˊɤɠ ŮɑɜŬɘ ɛɘŬ ɔɚɩůůŬ ɖ ɞˊɞɑŬ ɓɟɑůəŮŰŬɘ ůɢŮŭɧɜ ůŮ əɎɗŮ ŮɝɡˊɖɟŮŰɖŰɐ. 

ȹɘɎůɖɛŮɠ ŮűŬɟɛɞɔɏɠ ˊɞɡ ɏɢɞɡɜ ɔɟŬűŰŮɑ ůŮ ɔɚɩůůŬ PHP ŮɑɜŬɘ Űɞ ɔɜɤůŰɧ ɆɨůŰɖɛŬ 

ȹɘŬɢŮɑɟɘůɖɠ ɄŮɟɘŮɢɞɛɏɜɞɡ (Content Management System) Word Press, Űɞ Drupal  

əŬɘ Űɞ Joomla. 
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ȾȺūȷȿȷȽɃ 2 

2.1.   ȺɔəŬŰɎůŰŬůɖ  ˊɟɞɔɟŬɛɛɎŰɤɜ 

ɇɞ ˊɟɩŰɞ əŬɘ ɓŬůɘəɧŰŮɟɞ ˊɟɧɔɟŬɛɛŬ ˊɞɡ ɛŮŰŬűɏɟŬɛŮ ůŰɞɜ ɡˊɞɚɞɔɘůŰɐ ɛŬɠ 

ɔɘŬ ɜŬ ɛˊɞɟɏůɞɡɛŮ ɜŬ ŮɔəŬŰŬůŰɐůɞɡɛŮ Űɞ Joomla, ŮɑɜŬɘ ɞ WAMP. 

ũɟɎűɞɜŰŬɠ ůŰɞ Web Browser Google Chrome ɐ ůŰo Internet Explorer ɐ ůŮ 

ɧˊɞɘɞ Ɏɚɚɞ ˊɟɧɔɟŬɛɛŬ ˊŮɟɘɐɔɖůɖɠ Űɖɜ űɟɎůɖ Wamp, ɛŬɠ ŮɛűŬɜɑɕŮŰŬɘ ɖ ŮɘəɧɜŬ 1:  

 

 
ɳʽˁˈ˄ʰ м  WampServer 

ɆŰɞ ˊɟɩŰɞ link ŮˊɘɚɏɔɞɡɛŮ Download Wampserver 64bits, ɔɘŬŰɑ ɖ 

ŬɟɢɘŰŮəŰɞɜɘəɐ Űɞɡ ɡˊɞɚɞɔɘůŰɐ ɛŬɠ ŮɑɜŬɘ 64 bits. ȷɜ ɏɢŮŰŮ ɡˊɞɚɞɔɘůŰɐ ŬɟɢɘŰŮəŰɞɜɘəɐɠ 

32 bits, Ů́ ɘɚɏɝŮŰŮ  Download Wampserver 32bits. ɆŰɖɜ ůɡɜɏɢŮɘŬ ŮɛűŬɜɑɕŮŰŬɘ ɖ 

ŮɘəɧɜŬ ˊɞɡ ɓɚɏˊɞɡɛŮ ˊŬɟŬəɎŰɤ. ȷəɞɚɞɡɗɞɨɛŮ Űɘɠ ɞŭɖɔɑŮɠ ŮɔəŬŰɎůŰŬůɖɠ ɛɏɢɟɘ Űɞ 

ˊɟɧɔɟŬɛɛŬ ɜŬ ŮɔəŬŰŬůŰŬɗŮɑ ˊɚɐɟɤɠ ůŰɞɜ ɡˊɞɚɞɔɘůŰɐ ɛŬɠ. ȼ ɧɚɖ ŮɔəŬŰɎůŰŬůɖ 

ŭɘŬɟəŮɑ ɛɧɚɘɠ ɚɑɔŬ ɚŮˊŰɎ. 

ȼ ŮˊɘŰɡɢɐɠ ŮɔəŬŰɎůŰŬůɖ Űɞɡ Wamp űŬɑɜŮŰŬɘ Ŭˊɧ Űɞ ɢɟɩɛŬ ˊɞɡ ɗŬ ˊɎɟŮɘ Űɞ 

əɞɡŰɎəɘ əɎŰɤ ŭŮɝɘɎ. ȺɎɜ Űɞ əɞɡŰɎəɘ əŬŰŬɚɐɝŮɘ ůŮ ɢɟɩɛŬ ˊɟɎůɘɜɞ, ůɖɛŬɑɜŮɘ ɧŰɘ ɧɚŮɠ 

ɞɘ ɡˊɖɟŮůɑŮɠ Űɞɡ Wamp ɚŮɘŰɞɡɟɔɞɨɜ ůɤůŰɎ. ȺɎɜ əŬŰŬɚɐɝŮɘ ůŮ ˊɞɟŰɞəŬɚɑ ůɖɛŬɑɜŮɘ 

ɧŰɘ ɛɑŬ ŰɞɡɚɎɢɘůŰɞɜ ɡˊɖɟŮůɑŬ Űɞɡ ŭŮɜ ɚŮɘŰɞɡɟɔŮɑ ůɤůŰɎ. ȺɎɜ əŬŰŬɚɐɝŮɘ ůŮ əɧəəɘɜɞ 

ůɖɛŬɑɜŮɘ ɧŰɘ əŬɛɑŬ ɡˊɖɟŮůɑŬ Űɞɡ Wamp ŭŮɜ ɚŮɘŰɞɡɟɔŮɑ. 
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ɆŰɖɜ ŮɘəɧɜŬ 2 ɓɚɏˊɞɡɛŮ ɧŰɘ Űɞ əɞɡŰɎəɘ əŬŰɏɚɖɝŮ ůŮ ˊɟɎůɘɜɞ, ůɡɜŮˊɩɠ ɧɚŮɠ ɞɘ 

ɡˊɖɟŮůɑŮɠ Űɞɡ Wamp ɚŮɘŰɞɡɟɔɞɨɜ ůɤůŰɎ əŬɘ ɛˊɞɟɞɨɛŮ ɜŬ Űɞɜ ɢɟɖůɘɛɞˊɞɘɐůɞɡɛŮ. 

 

ɳʽˁˈ˄ʰ н  WampServer 

 

2.1.1.   ȹɖɛɘɞɡɟɔɑŬ ɓɎůɖɠ ŭŮŭɞɛɏɜɤɜ ˊɟɘɜ Űɖɜ ŮɔəŬŰɎůŰŬůɖ Űɞɡ Joomla. 
 

Ʉɟɘɜ ˊɟɞɢɤɟɐůɞɡɛŮ ůŰɖɜ ŮɔəŬŰɎůŰŬůɖ Űɞɡ Joomla ŭɖɛɘɞɡɟɔɐůŬɛŮ ɛɑŬ ɓɎůɖ 

ŭŮŭɞɛɏɜɤɜ ɔɘŬ ɜŬ ɛˊɞɟɏůŮɘ ɜŬ ůɡɜŭŮɗŮɑ ɛŮ ŮəŮɑɜɖ əŬŰɎ Űɖɜ ŭɘɎɟəŮɘŬ Űɖɠ 

ŮɔəŬŰɎůŰŬůɐ Űɞɡ.  

ȷɟɢɘəɎ ŬɜɞɑɝŬɛŮ ɏɜŬ ˊɟɧɔɟŬɛɛŬ ˊŮɟɘɐɔɖůɖɠ, ɧ́ ɞɘɞ ŮˊɘɗɡɛɞɨɛŮ (ŮˊɘɚɏɝɞɡɛŮ Űɞ 

Google Chrome) , ˊɚɖəŰɟɞɚɞɔɞɨɛŮ Űɖɜ ŭɘŮɨɗɡɜůɖ : localhost/phpmyadmin əŬɘ 

ŮɛűŬɜɑɕŮŰŬɘ ɖ ŮɘəɧɜŬ 3: 
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ɳʽˁˈ˄ʰ 3  Phpmyadmin 

ɆŮ ˊŮɟɑˊŰɤůɖ ˊɞɡ ɕɖŰŮɑŰŬɘ Username əŬɘ Password (ɧˊɤɠ ůɡɜɏɓɖ ůŮ ŮɛɏɜŬ) 

ŬɜŬɕɐŰɖůŬ ɚɨůɖ ůŰɞ ˊɟɧɓɚɖɛŬ əŬɘ əŬŰɏɚɖɝŬ ɧŰɘ ŰŬ default Username əŬɘ Password 

ŮɑɜŬɘ Username : root əŬɘ Password : ò ñ. ȼ Ůɑůɞŭɞɠ ɏŭɤůŮ Űɖɜ ŮɘəɧɜŬ 4: 

 

ɳʽˁˈ˄ʰ 4  ɲʹ˃ʽˇˎˊʴʾʰ ʲʱˋʹˌ ʵʶʵˇ˃ʷ˄˖˄ hotel1 

ɆŰɖɜ ˊŬɟŬˊɎɜɤ ŮɘəɧɜŬ ɔɘŬ Űɖɜ ŭɖɛɘɞɡɟɔɑŬ ɓɎůɖɠ ŮˊɘɚɏɝŬɛŮ Databases. 

ȷəɞɚɞɨɗɤɠ ɔɘŬ Űɖɜ ŭɖɛɘɞɡɟɔɑŬ Űɖɠ əŬɘɜɞɨɟɔɘŬɠ ɓɎůɖɠ ɔɟɎɣŬɛŮ ɧɜɞɛŬ (ůŰɖɜ 

ˊŮɟɑˊŰɤůɐ ɛŬɠ hotel1) əŬɘ ůŰɖɜ Ůˊɘɚɞɔɐ Collation ŮˊɘɚɏɝŬɛŮ utf8_general_ci. ȼ 

ŭɖɛɘɞɡɟɔɑŬ Űɖɠ ɓɎůɖɠ hotel1 ɞɚɞəɚɖɟɩɗɖəŮ ɛŮ Űɖɜ Ůˊɘɚɞɔɐ Create. ȼ ŭɘŬˊɑůŰɤůɖ 

Űɖɠ ŭɖɛɘɞɡɟɔɑŬɠ űŬɑɜŮŰŬɘ Ŭˊɧ Űɞ ɛɐɜɡɛŬ ŮˊɘŰɡɢɞɨɠ ŭɖɛɘɞɡɟɔɑŬɠ Űɖɠ ɓɎůɖɠ, ŬɚɚɎ əŬɘ 

Ŭˊɧ Űɖɜ ŮɛűɎɜɘůɖ Űɞɡ ɞɜɧɛŬŰɧɠ Űɖɠ ŬɟɘůŰŮɟɎ ůŰɞɜ ˊɑɜŬəŬ Űɤɜ ɓɎůŮɤɜ ɧˊɤɠ 

űŬɑɜŮŰŬɘ ůŰɖɜ ŮɘəɧɜŬ 5. 
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ɳʽˁˈ˄ʰ 5  ɳˉʽˍˎ˔ʺˌ ʵʹ˃ʽˇˎˊʴʾʰ ˍʹˌ ʲʱˋʹˌ hotel1 

2.2.   ȺɔəŬŰɎůŰŬůɖ Űɞɡ Joomla 
 

ɂŮəɘɜɐůŬɛŮ ɛŮ Űɖɜ ŭɖɛɘɞɡɟɔɑŬ Ůɜɧɠ űŬəɏɚɞɡ ŮˊɘɚɏɔɞɜŰŬɠ ɏɜŬ ɧɜɞɛŬ hotel1 

ůŰɖɜ ŭɘŮɨɗɡɜůɖ C:/wamp/www ɩůŰŮ ɜŬ ŮɔəŬŰŬůŰɐůɞɡɛŮ ůŮ ŬɡŰɧ Űɞ űɎəŮɚɞ Űɞ 

Joomla. ũɘŬ Űɖɜ  ŮɔəŬŰɎůŰŬůɖ Űɞɡ Joomla ŬɜŬűɏɟŬɛŮ Űɘɠ ŭɘŮɡɗɨɜůŮɘɠ Ŭˊô Űɘɠ ɞˊɞɑŮɠ 

ɛˊɞɟɞɨɛŮ ɜŬ əŬŰŮɓɎůɞɡɛŮ Űɞ ˊɟɧɔɟŬɛɛŬ. ȺɛŮɑɠ ŮˊɘɚɏɝŬɛŮ Űɖɜ ŭɘŮɨɗɡɜůɖ Űɖɠ 

ɘůŰɞůŮɚɑŭŬɠ Űɞɡ Joomla (1). ɇɖɜ ˊɚɖəŰɟɞɚɞɔɐůŬɛŮ ůŮ ɏɜŬɜ űɡɚɚɞɛŮŰɟɖŰɐ  əŬɘ 

ŮɛűŬɜɑɕŮŰŬɘ ɖ ŮɘəɧɜŬ 6. ȷˊɧ ŬɡŰɐɜ ŮˊɘɚɏɝŬɛŮ Download. 

 

ɳʽˁˈ˄ʰ 6  ɹ̀ ˍˇˋʶ˂ʾʵʰ ˍˇˎ WƻƻƳƭŀ 
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    ȺɛűŬɜɑɕŮŰŬɘ ɖ ȺɘəɧɜŬ 7. 

  

ɳʽˁˈ˄ʰ 7  ɼʰˍʷʲʰˋ˃ʰ ˍʹˌ ʷˁʵˇˋʹˌ Joomla 3.6.4 

ȺˊɘɚɏɔɞɡɛŮ Űɖɜ ŰŮɚŮɡŰŬɑŬ ɏəŭɞůɖ Űɞɡ Joomla 3.6.4 əŬɘ ˊŬŰɎɛŮ Download ɔɘŬ ɜŬ 

əŬŰɏɓŮɘ Űɞ ˊɟɧɔɟŬɛɛŬ ůŮ ɛɞɟűɐ .zip, ɔŮɔɞɜɧɠ Űɞ ɞˊɞɑɞ ŬˊŬɘŰŮɑ ɛŮɟɘəɎ ɚŮˊŰɎ Űɖɠ 

ɩɟŬɠ. ɇɞ ŬɟɢŮɑɞ .zip Ŭˊɧ Űɘɠ ɚɐɣŮɘɠ Űɞ ɛŮŰŬűɏɟɞɡɛŮ ůŰɞ űɎəŮɚɞ hotel1, əɎɜɞɡɛŮ 

Extract ŮəŮɑ ɛɏůŬ əŬɘ ˊɚɖəŰɟɞɚɞɔɞɨɛŮ Űɞ URL localhost/hotel1/administrator 

ˊɟɞəŮɘɛɏɜɞɡ ɜŬ ŮɔəŬŰŬůŰɐůɞɡɛŮ Űɞ Joomla əŬɘ ɜŬ Űɞ ůɡɜŭɏůɞɡɛŮ ɛŮ Űɖ ɓɎůɖ. 

ȺɛűŬɜɑɕŮŰŬɘ ˊŬɟɎɗɡɟɞ ɓŬůɘəɩɜ ɟɡɗɛɑůŮɤɜ ůŰɞ ɞˊɞɑɞ ůɡɛˊɚɖɟɩɜɞɡɛŮ ŰŬ ˊŮŭɑŬ 

ˊɞɡ ɓɟɑůəɞɜŰŬɘ ůŰɘɠ ȸŬůɘəɏɠ ɅɡɗɛɑůŮɘɠ (ɧɢɘ ɧɚŬ, ŮəŮɑɜŬ ˊɞɡ ŮɑɜŬɘ ŬˊŬɟŬɑŰɖŰŬ). ɆŰɞ 

ˊŮŭɑɞ ȳɜɞɛŬ  ȽůŰɞůŮɚɑŭŬɠ * ůɡɛˊɚɖɟɩɜɞɡɛŮ Űɞ ɧɜɞɛŬ Űɖɠ ɘůŰɞůŮɚɑŭŬɠ ɛŬɠ Űɞ ɞˊɞɑɞ 

ˊɟɞűŬɜɩɠ ɗŬ ɓɚɏˊɞɡɜ ɞɘ ŮˊɘůəɏˊŰŮɠ (ůŰɖɜ ˊŮɟɑˊŰɤůɐ ɛŬɠ ɂŮɜɞŭɞɢŮɑɞ ɆŰŬɡɟɎəɖɠ). 

ɆŰɞ ˊŮŭɑɞ ȼɚŮəŰɟɞɜɘəɧ ŰŬɢɡŭɟɞɛŮɑɞ ȹɘŬɢŮɘɟɘůŰɐ * ˊɚɖəŰɟɞɚɞɔɞɨɛŮ Űɞ e-mail Űɞɡ 

ȹɘŬɢŮɘɟɘůŰɐ (ŭɖɚŬŭɐ Űɞ e-mail ɛŬɠ). ɆŰɞ ˊŮŭɑɞ ȳɜɞɛŬ ɢɟɐůŰɖ ȹɘŬɢŮɘɟɘůŰɐ * 

ˊɚɖəŰɟɞɚɞɔɞɨɛŮ ɏɜŬ ɧɜɞɛŬ ɢɟɐůŰɖ ɔɘŬ Űɞɜ ȹɘŬɢŮɘɟɘůŰɐ. ɆŰɞ ˊŮŭɑɞ Ⱦɤŭɘəɧɠ 

ȹɘŬɢŮɘɟɘůŰɐ * ɓɎɕɞɡɛŮ ɏɜŬɜ əɤŭɘəɧ ɔɘŬ Űɞɜ ȹɘŬɢŮɘɟɘůŰɐ, əŬɘ ůŰɞ ˊŮŭɑɞ ȺˊɘɓŮɓŬɑɤůɖ 

Ⱦɤŭɘəɞɨ ȹɘŬɢŮɘɟɘůŰɐ * ŮˊŬɜŬɚŬɛɓɎɜɞɡɛŮ Űɞɜ ɑŭɘɞ əɤŭɘəɧ ˊɞɡ ˊɚɖəŰɟɞɚɞɔɐůŬɛŮ 

ůŰɞ ˊŮŭɑɞ Ⱦɤŭɘəɧɠ ȹɘŬɢŮɘɟɘůŰɐ, ɔɘŬ ŮˊɘɓŮɓŬɑɤůɖ ɧŰɘ ˊɚɖəŰɟɞɚɞɔɐůŬɛŮ Űɞɜ ůɤůŰɧ 

əɤŭɘəɧ. Ƀɘ əɤŭɘəɞɑ ŮɑɜŬɘ ŬˊŬɟŬɑŰɖŰɞɘ ɔɘŬ ůɨɜŭŮůɖ Űɞɡ ȹɘŬɢŮɘɟɘůŰɐ ɛŮ Űɞ ˊŮɟɘɓɎɚɚɞɜ 

ŭɘŬɢŮɑɟɘůɖɠ Űɞɡ Joomla. ɇɞ ˊŬɟɎɗɡɟɞ ůɡɛˊɚɖɟɤɛɏɜɞ űŬɑɜŮŰŬɘ ůŰɖɜ ŮɘəɧɜŬ 8. 
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ɳʽˁˈ˄ʰ 8  ɰʰˋʽˁʷˌ ʄˎʻ˃ʾˋʶʽˌ 

ɆŰŬ ɡˊɧɚɞɘˊŬ ˊŮŭɑŬ ŭŮɜ ɢɟŮɘɎůŰɖəŮ ɜŬ ůɡɛˊɚɖɟɩůɞɡɛŮ ŰɑˊɞŰŬ əŬɘ ˊŬŰɎɛŮ 

ŮˊɧɛŮɜɞ. 

ɆŰɞ ˊŬɟɎɗɡɟɞ ˊɞɡ ŮɛűŬɜɑɕŮŰŬɘ ˊɟɏˊŮɘ ɜŬ ɔɑɜŮɘ ɖ ůɨɜŭŮůɖ Űɞɡ Joomla ɛŮ Űɖɜ 

ɓɎůɖ ŭŮŭɞɛɏɜɤɜ.  

ɆŰŬ ŬɜŰɑůŰɞɘɢŬ ˊŮŭɑŬ ůɡɛˊɚɖɟɩɜɞɡɛŮ: 

Å Ⱥɑŭɞɠ ɓɎůɖɠ ŭŮŭɞɛɏɜɤɜ *  ŮˊɘɚɏɔɞɡɛŮ Űɖɜ MySQLi . 

Å ȳɜɞɛŬ ŭɘŬəɞɛɘůŰɐ * ˊɚɖəŰɟɞɚɞɔɞɨɛŮ localhost. 

Å ȳɜɞɛŬ ɢɟɐůŰɖ * ˊɚɖəŰɟɞɚɞɔɞɨɛŮ root. 

Å ȳɜɞɛŬ Űɖɠ ȸɎůɖɠ ȹŮŭɞɛɏɜɤɜ * ˊɚɖəŰɟɞɚɞɔɞɨɛŮ hotel1. 

ɇɞ ɄɟɧɗŮɛŬ ˊɑɜŬəŬ * ŮɑɜŬɘ ůɡɛˊɚɖɟɤɛɏɜɞ (by default) əŬɘ ŭŮɜ ɢɟŮɘɎɕŮŰŬɘ ŬɚɚŬɔɐ. 

ɇɞ ˊŬɟɎɗɡɟɞ ůɡɛˊɚɖɟɤɛɏɜɞ űŬɑɜŮŰŬɘ ůŰɖɜ ŮɘəɧɜŬ 9. 
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ɳʽˁˈ˄ʰ 9  ɰʰˋʽˁʷˌ ˊˎʻ˃ʾˋʶʽˌ ʲʱˋʹˌ ʵʶʵˇ˃ʷ˄˖˄ ˁʰʽ ˋˏ˄ʵʶˋʹ ˍʹˌ ˃ʶ ˍˇ Joomla 

ɆŰŬ ɡˊɧɚɞɘˊŬ ˊŮŭɑŬ ŭŮɜ ɢɟŮɘɎůŰɖəŮ ɜŬ ůɡɛˊɚɖɟɩůɞɡɛŮ ŰɑˊɞŰŬ, ŬˊɚɎ ŮˊɘɚɏɔɞɡɛŮ 

ŮˊɧɛŮɜɞ. 

 

ɳʽˁˈ˄ʰ 10  ɳ̄ ʽ˂ˇʴʺ ˍˇˎ ŎƘŜŎƪ ōƻȄ ʃˊˇʶˉʽ˂ʶʴ˃ʷ˄ˇ ʶ˄ʵʶʽˁˍʽˁˈ ˉʶˊʽʶ˔ˈ˃ʶ˄ˇ ˋˍʰ ʰʴʴ˂ʽˁʱ όGB) 

ɆŰɖɜ ŮɘəɧɜŬ 10 ˊɞɡ ŮɛűŬɜɑůŰɖəŮ Ŭˊɧ Űɞ check box ŮˊɘɚɏɔɞɡɛŮ ɔɘŬ Űɖɜ 

ȺɔəŬŰɎůŰŬůɖ ŮɜŭŮɘəŰɘəɞɨ ˊŮɟɘŮɢɞɛɏɜɞɡ Űɞ ɐŭɖ ɄɟɞŮˊɘɚŮɔɛɏɜɞ ȺɜŭŮɘəŰɘəɧ 

ˊŮɟɘŮɢɧɛŮɜɞ ůŰŬ ŬɔɔɚɘəɎ (GB) əŬɘ ŮˊɘɚɏɔɞɡɛŮ ȺɔəŬŰɎůŰŬůɖ. ɀŮŰɎ Ŭˊɧ ɚɑɔŬ ɚŮˊŰɎ 

ˊŬɟŬŰɖɟɞɨɛŮ ɧŰɘ ɖ ŮɔəŬŰɎůŰŬůɖ Űɞɡ Joomla ˊɟŬɔɛŬŰɞˊɞɘɐɗɖəŮ ŮˊɘŰɡɢɩɠ 

ŮˊɘɓŮɓŬɘɩɜɞɜŰŬɠ ɛŮ ɛɐɜɡɛŬ ɧˊɤɠ űŬɑɜŮŰŬɘ ůŰɖɜ ŮɘəɧɜŬ 11 ˊɞɡ ŮɛűŬɜɑɕŮŰŬɘ. 
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ɳʽˁˈ˄ʰ 11  ɮ˒ ʰʾˊʶˋʹ ˍˇˎ ˒ʰˁʷ˂ˇˎ INSTALLATION 

 

ɇŮɚŮɡŰŬɑŬ əɑɜɖůɖ ɧˊɤɠ ɎɚɚɤůŰŮ ɛŬɠ ˊɟɞŰɟɏˊŮɘ, ŮɑɜŬɘ ɜŬ ŭɘŬɔɟɎɣɞɡɛŮ Űɞ űɎəŮɚɞ 

INSTALLATION  ˊŬŰɩɜŰŬɠ Űɞ ůɢŮŰɘəɧ ˊɚɐəŰɟɞ. 

ɀŮ Űɖɜ ŮˊɘŰɡɢɐ ŮɔəŬŰɎůŰŬůɖ Űɞɡ Joomla ŮɑɛŬůŰŮ ůŮ ɗɏůɖ ɜŬ ŬˊɞəŰɐůɞɡɛŮ 

ˊɟɧůɓŬůɖ ůŰɞ ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ, ɛɏůɤ Űɞɡ əɞɡɛˊɘɞɨ ȹɘŬɢŮɘɟɘůŰɐɠ ŬɚɚɎ əŬɘ ɜŬ 

ŬˊɞəŰɐůɞɡɛŮ ˊɟɧůɓŬůɖ ůŰɖɜ əŮɜŰɟɘəɐ ůŮɚɑŭŬ Űɞɡ ɛɏůɤ Űɞɡ əɞɡɛˊɘɞɨ ȽůŰɞůŮɚɑŭŬ. 

ũɘŬ ɜŬ ŬˊɞəŰɐůɞɡɛŮ ˊɟɧůɓŬůɖ ůŰɞ ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ Joomla, ŮˊɘɚɏɔɞɡɛŮ 

ȹɘŬɢŮɘɟɘůŰɐɠ. ȺɛűŬɜɑɕŮŰŬɘ ɖ űɧɟɛŬ ɛŮ ŰŬ ˊŮŭɑŬ Űɤɜ Username əŬɘ Password. ɇŬ 

ˊɚɖəŰɟɞɚɞɔɞɨɛŮ əŬɘ ˊŬŰɎɛŮ Log in. 

ʆˇ ˉʰˊʱʻˎˊˇ ˉˇˎ ŮɛűŬɜɑɕŮŰŬɘ ˊŮɟɘɏɢŮɘ Űɞ Control Panel ɧˊɤɠ ŭŮɑɢɜŮɘ ɖ ŮɘəɧɜŬ 12. 
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ɳʽˁˈ˄ʰ 12  ɲʽʰ˔ʶʽˊʽˋˍʽˁˈ ˍˇˎ WƻƻƳƭŀ  (ʆ˃ʺ˃ʰ Backend) 

ɇɞ ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ Joomla ˊɞɡ ŮɛűŬɜɑůŰɖəŮ ˊŬɟɏɢŮɘ ɧɚŬ ŰŬ ŬˊŬɟŬɑŰɖŰŬ 

ŮɟɔŬɚŮɑŬ əŬɘ ɧɚŮɠ Űɘɠ ŬˊŬɟŬɑŰɖŰŮɠ ŭɡɜŬŰɧŰɖŰŮɠ ɛɏůɤ Űɤɜ ɞˊɞɑɤɜ ɞ ȹɘŬɢŮɘɟɘůŰɐɠ 

ɛˊɞɟŮɑ ɜŬ ŭɖɛɘɞɡɟɔɐůŮɘ ɛɑŬ ɘůŰɞůŮɚɑŭŬ əŬɘ ɜŬ Űɖɜ ŰɟɞˊɞˊɞɘɐůŮɘ ɧŰŬɜ ɢɟŮɘŬůŰŮɑ. 

ɀˊɞɟŮɑ ɜŬ ŭɖɛɘɞɡɟɔɐůŮɘ, ɜŬ ŮˊŮɝŮɟɔŬůŰŮɑ, ɜŬ ŭɘŬɔɟɎɣŮɘ, ɜŬ ŬˊɞəɟɨɣŮɘ, ŬɚɚɎ əŬɘ ɜŬ 

ŮɛűŬɜɑůŮɘ ɎɟɗɟŬ, ɛŮɜɞɨ, ůŰɞɘɢŮɑŬ ɛŮɜɞɨ, Modules. ɀˊɞɟŮɑ ɜŬ ŮɔəŬŰŬůŰɐůŮɘ ɜɏŬ 

Templates əŬɘ ɜŬ ŮˊŮɝŮɟɔŬůŰŮɑ ŰŬ ɑŭɘŬ ŰŬ Templates. ɀˊɞɟŮɑ ɜŬ ŬɜŮɓɎůŮɘ ŮɘəɧɜŮɠ, ɜŬ 

ŮˊŮɝŮɟɔŬůŰŮɑ Űɘɠ ɟɡɗɛɑůŮɘɠ Űɞɡ Joomla, ɜŬ ŮɔəŬɗɘůŰɎ ɜɏŬ Modules, Components əŬɘ 

Plugins, ɜŬ ŮɔəŬɗɘůŰɎ Űɞ Component ȷkeeba Backup ɔɘŬ ɜŬ əɟŬŰɎŮɘ ɞ ȹɘŬɢŮɘɟɘůŰɐɠ 

ŬɜŰɑɔɟŬűɞ ŬůűɎɚŮɘŬɠ ɞɚɧəɚɖɟɖɠ Űɘɠ ɘůŰɞůŮɚɑŭŬɠ əŬɘ ɧŰɘ Ɏɚɚɞ ŮɑɜŬɘ ŬˊŬɟŬɑŰɖŰɞ ɔɘŬ 

Űɖɜ əŬɚɨŰŮɟɖ ŮɛűɎɜɘůɖ ɛɘŬɠ ŭɡɜŬɛɘəɐɠ ɘůŰɞůŮɚɑŭŬɠ. 

ũɘŬ ɜŬ ŭɞɨɛŮ ŰɩɟŬ Űɖɜ əŮɜŰɟɘəɐ ůŮɚɑŭŬ Űɞɡ Joomla ˊŬŰɎɛŮ ˊɎɜɤ ŭŮɝɘɎ ůŰɞ 

ɂŮɜɞŭɞɢŮɑɞ ɆŰŬé (ŭɖɚŬŭɐ ɂŮɜɞŭɞɢŮɑɞ ɆŰŬɡɟɎəɖɠ ŬˊɚɎ ŮəŮɑ ŭŮɜ ɢɤɟɎŮɘ ɧɚɞ Űɞ 

ɧɜɞɛŬ). ȾɎɜɞɜŰŬɠ əɚɘə ɓɚɏˊɞɡɛŮ Űɖɜ əŮɜŰɟɘəɐ ůŮɚɑŭŬ ɧˊɤɠ ŭŮɑɢɜŮɘ ɖ ŮɘəɧɜŬ 13. 
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ɳʽˁˈ˄ʰ 13  ɼʶ˄ˍˊʽˁʺ ˋʶ˂ʾʵʰ ˍˇˎ WƻƻƳƭŀ (ʆ˃ʺ˃ʰ Frontent) 
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ȾȺūȷȿȷȽɃ 3 

3.1.   ȼ ŭɞɛɐ Űɞɡ Joomla 

ɆŰɞ Joomla ŮɛűŬɜɑɕɞɜŰŬɘ ŭɨɞ ŰɛɐɛŬŰŬ: 

Å ɇɞ ŰɛɐɛŬ Frontend (ȹɖɛɧůɘɞ ŰɛɐɛŬ, ɐ ɛˊɟɞůŰɘɜɧ ŰɛɐɛŬ). 

ɇɞ ŰɛɐɛŬ Frontend ŮɑɜŬɘ ŬɡŰɧ ˊɞɡ ɓɚɏˊɞɡɜ ɞɘ ɢɟɐůŰŮɠ ɛɧɚɘɠ ŮˊɘůəŮűŰɞɨɜ Űɖɜ 

ɘůŰɞůŮɚɑŭŬ  (ŭɖɚŬŭɐ ŮɑɜŬɘ ɖ əŮɜŰɟɘəɐ ůŮɚɑŭŬ ɖ ɞˊɞɑŬ ŮɛűŬɜɑɕŮŰŬɘ ůŰɞɡɠ ɢɟɐůŰŮɠ)  

Joomla  (3). 

Å ɇɞ ŰɛɐɛŬ Backend  ( ɄŮɟɘɞɢɐ ŭɘŬɢŮɑɟɘůɖɠ - ˊɑůɤ ŰɛɐɛŬ). 

ȺɑɜŬɘ Űɞ ˊŮɟɘɓɎɚɚɞɜ ŮɟɔŬůɑŬɠ ɔɘŬ Űɞɡɠ ȹɘŬɢŮɘɟɘůŰɏɠ ɘůŰɞůŮɚɑŭŬɠ ɞɘ ɞˊɞɑɞɘ 

ŮˊŮɝŮɟɔɎɕɞɜŰŬɘ əŬɘ ŮɛűŬɜɑɕɞɡɜ ŰŬ ˊŮɟɘŮɢɧɛŮɜŬ Űɤɜ ɘůŰɞůŮɚɑŭɤɜ ɢɟɖůɘɛɞˊɞɘɩɜŰŬɠ ŰŬ 

ŭɘɎűɞɟŬ ŮɟɔŬɚŮɑŬ ŬɚɚɎ əŬɘ Űɘɠ ŭɡɜŬŰɧŰɖŰŮɠ ˊɞɡ ˊŮɟɘɏɢŮɘ Űɞ Joomla. 

 

3.2.   ɇŬ ɀŮɜɞɨ 

ɇŬ ɛŮɜɞɨ ŮɑɜŬɘ ŬɜŰɘəŮɑɛŮɜŬ ˊɚɞɐɔɖůɖɠ ˊɞɡ əŬɗɞɟɑɕɞɡɜ Űɞ ˊɩɠ ɗŬ ŮɛűŬɜɘůŰŮɑ 

Űɞ ˊŮɟɘŮɢɧɛŮɜɞ Űɖɠ ůŮɚɑŭŬɠ. ȰɜŬ ɛŮɜɞɨ ɛˊɞɟŮɑ ɜŬ ˊŮɟɘɏɢŮɘ ɏɜŬ ɖ ˊŮɟɘůůɧŰŮɟŬ 

ůŰɞɘɢŮɑŬ ɀŮɜɞɨ, ɏŰůɘ ɩůŰŮ əɎɜɞɜŰŬɠ click ˊɎɜɤ ůŮ ŬɡŰɎ ɜŬ ŮɛűŬɜɑɕŮŰŬɘ Űɞ 

ˊŮɟɘŮɢɧɛŮɜɞ Űɖɠ ůŮɚɑŭŬɠ.   

 

3.3.   ȺˊŮəŰɎůŮɘɠ 

ȺɑɜŬɘ ɏɜŬ ɛŮɜɞɨ ůŰɖɜ ɔɟŬɛɛɐ ɛŮɜɞɨ Űɞɡ ŰɛɐɛŬŰɞɠ Backend Űɞɡ Joomla əŬɘ 

ɢɟɖůɘɛɞˊɞɘŮɑŰŬɘ ɔɘŬ ɜŬ ɛˊɞɟŮɑ ɞ ȹɘŬɢŮɘɟɘůŰɐɠ ɜŬ ŮɔəŬɗɘůŰɎ ŭɘɎűɞɟŬ ŬɟɢŮɑŬ .zip Ŭˊɧ 

Űɞɜ ɡˊɞɚɞɔɘůŰɐ Űɞɡ ůŰɞ ˊŮɟɘɓɎɚɚɞɜ Űɞɡ Joomla. 

3.3.1.   Ⱥɑŭɖ ŮˊŮəŰɎůŮɤɜ 

ɈˊɎɟɢɞɡɜ ˊɏɜŰŮ Ⱥɑŭɖ ŮˊŮəŰɎůŮɤɜ: 

Å ɄɟɧŰɡˊŬ (Templates) 

Å ȺűŬɟɛɞɔɏɠ (Components) 

Å ȺɜɗɏɛŬŰŬ (Modules) 

Å ɄɟɧůɗŮŰŬ (Plugins) 

Å ũɚɩůůŮɠ (Languages) 
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3.3.2.    ɄɟɧŰɡˊŬ (Templates) 
 

ɇŬ Templates, ŮɑɜŬɘ ɏɜŬ Ůɑŭɞɠ ŮˊɏəŰŬůɖɠ Űɞɡ Joomla, ŰŬ ɞˊɞɑɞ ɞɡůɘŬůŰɘəɎ ŮɑɜŬɘ 

Űɞ Design Űɘɠ ůŮɚɑŭŬɠ. ȾŬɗɞɟɑɕɞɡɜ Űɞ ˊɩɠ ŮɛűŬɜɑɕŮŰŬɘ ɛɑŬ ůŮɚɑŭŬ (Űɞ ɢɟɩɛŬ Űɖɠ 

ůŮɚɑŭŬɠ, Űɞ ɛɏɔŮɗɞɠ, Űɞɜ Űɨˊɞ Űɤɜ ŭɘŬűɧɟɤɜ  ɔɟŬɛɛŬŰɞůŮɘɟɩɜ ˊɞɡ ˊŮɟɘɏɢŮɘ ɐ ɗŬ 

ˊŮɟɘɏɢŮɘ ɖ ůŮɚɑŭŬ, ŬɚɚɎ əŬɘ Űɖɜ ŰɞˊɞɗɏŰɖůɖ Űɤɜ Modules əŬɘ Űɤɜ Component ůŰɖɜ 

ůŮɚɑŭŬ əɚˊ). ɈˊɎɟɢŮɘ ˊɚɖɗɩɟŬ ɏŰɞɘɛɤɜ ŭɘŬɗɏůɘɛɤɜ Templates ŰŬ ɞˊɞɑŬ ɛˊɞɟɞɨɛŮ ɜŬ 

ɓɟɞɨɛŮ ůŰɞ ŭɘŬŭɑəŰɡɞ ɔɟɎűɞɜŰŬɠ ŬˊɚɎ ůŮ ɏɜŬ Browser ñTemplates for Joomlaò. ȷɜ 

ˊɚɖəŰɟɞɚɞɔɐůɞɡɛŮ ñTemplates for Joomla freeò ɗŬ ɓɟɞɨɛŮ Templates ˊɞɡ 

ŭɘŬŰɑɗŮɜŰŬɘ ŭɤɟŮɎɜ Youtube (4). 

3.3.3.     ȺűŬɟɛɞɔɏɠ (Components) 

ɇŬ Components ŮɑɜŬɘ ɓŬůɘəɏɠ ŮˊŮəŰɎůŮɘɠ Űɞɡ Joomla. ɇŬ Components ˊɞɡ 

ɢɟɖůɘɛɞˊɞɘɐůŬɛŮ ůŰɖɜ ůŮɚɑŭŬ ɛŬɠ ŮɑɜŬɘ Űɞ Component ɔɘŬ ŰŬ ɎɟɗɟŬ Űo ɞˊɞɑɞ 

ɢɟŮɘɎɕŮŰŬɘ ɔɘŬ Űɖɜ ŮɛűɎɜɘůɖ Űɤɜ Ɏɟɗɟɤɜ ůŰɖɜ ůŮɚɑŭŬ ɛŬɠ, Űɞ Component Akeeba 

Backup, Űɞɜ əŮɘɛŮɜɞɔɟɎűɞ JCE Editor əŬɘ ɛɑŬ űɧɟɛŬ ŮˊɘəɞɘɜɤɜɑŬɠ əŬɘ ŰŬ ɞˊɞɑŬ 

ŬɜŬűɏɟɞɡɛŮ ůŰɖɜ ůɡɜɏɢŮɘŬ Űɖɠ ˊŰɡɢɘŬəɐɠ ɛŬɠ ŮɟɔŬůɑŬɠ. ɆŰŬ Templates ɛɧɜɞ ɏɜŬ 

Component ŮɑɜŬɘ ŮɜŮɟɔɧ əɎɗŮ űɞɟɎ ůŮ ɛɑŬ ůŮɚɑŭŬ. ɇɞ Component ɓŬůɑɕŮŰŬɘ ůŰɞ 

ɛŮɜɞɨ ɔɘŬ Űɖɜ ŮɛűɎɜɘůɐ Űɞɡ əŬɘ ɛɏůŬ Ŭˊɧ Űɘɠ ɟɡɗɛɑůŮɘɠ Űɞɡ ɛŮɜɞɨ ŮɑɜŬɘ əŬɘ ɞɘ 

ɟɡɗɛɑůŮɘɠ Űɞɡ Component əŬɘ ɡˊɎɟɢɞɡɜ ˊɞɚɚɏɠ ɟɡɗɛɑůŮɘɠ ɔɘŬ ɏɜŬ Component, 

Ⱥˊɑůɖɠ Űɞ Component ɏɢŮɘ ɛɑŬ əŬɘ ɛɞɜŬŭɘəɐ ɗɏůɖ ůŰɞ Template Youtube (17). 

3.3.4.   ȺɜɗɏɛŬŰŬ (Modules) 
 

ɇŬ Modules ŮɑɜŬɘ ˊɟɞɔɟɎɛɛŬŰŬ ŰŬ ɞˊɞɑŬ ŮəŰŮɚɞɨɜ ŮɟɔŬůɑŮɠ, ɧˊɤɠ ŮɑɜŬɘ ɖ 

ŮɛűɎɜɘůɖ Ůɜɧɠ ɖɛŮɟɞɚɞɔɑɞɡ, Űɞ ˊŮŭɑɞ ŬɜŬɕɐŰɖůɖɠ (ɧˊɞɡ ɛˊɞɟɞɨɛŮ ɜŬ ŬɜŬɕɖŰɐůɞɡɛŮ 

ˊɚɖɟɞűɞɟɑŮɠ), ɖ ŮɛűɎɜɘůɖ əɘɜɞɨɛŮɜɤɜ Ůɘəɧɜɤɜ ɐ gallery, ɖ űɧɟɛŬ ŮˊɘəɞɘɜɤɜɑŬɠ ɔɘŬ 

ůɨɜŭŮůɖ əɚˊ. ȺɑɜŬɘ ůŰɞɘɢŮɑŬ ŰŬ ɞˊɞɑŬ ŮɛűŬɜɑɕɞɜŰŬɘ ůŮ ɗɏůŮɘɠ ˊɞɡ ɏɢŮɘ ɞɟɑůŮɘ Űɞ 

Template ŮəŰŮɚɩɜŰŬɠ əɎˊɞɘŬ ůɡɔəŮəɟɘɛɏɜɖ ɚŮɘŰɞɡɟɔɘəɧŰɖŰŬ sch (5). 

3.3.5.    ɄɟɧůɗŮŰŬ (Plugins) 

ɇŬ Plugins ŮɑɜŬɘ ŮˊŮəŰɎůŮɘɠ Űɞɡ ɡˊɧɓŬɗɟɞɡ (background) Űɞɡ Joomla əŬɘ ŰŬ 

ɞˊɞɑŬ ɓŮɚŰɘɩɜɞɡɜ  Űɘɠ ɚŮɘŰɞɡɟɔɘəɏɠ ŭɡɜŬŰɧŰɖŰŮɠ Űɞɡ ůɡůŰɐɛŬŰɞɠ. ɇɞ WikiBot, ɔɘŬ 

ˊŬɟɎŭŮɘɔɛŬ, ŮˊɘŰɟɏˊŮɘ ůŰɞ ȹɖɛɘɞɡɟɔɧ ˊŮɟɘŮɢɞɛɏɜɞɡ ůŰɞ Joomla ɜŬ ɢɟɖůɘɛɞˊɞɘɐůŮɘ 

çWikitagsè ůŰŬ ɎɟɗɟŬ Űɞɡ, ŭɖɚŬŭɐ ŮŰɘəɏŰŮɠ (tags) ɞɘ ɞˊɞɑŮɠ ŭɖɛɘɞɡɟɔɞɨɜ ŬɡŰɧɛŬŰŬ 
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ŭɡɜŬɛɘəɞɨɠ ɡˊŮɟůɡɜŭɏůɛɞɡɠ (hyperlinks) ůŮ ŬɜŰɑůŰɞɘɢŬ ɎɟɗɟŬ ůŰɖ Wikipedia  sch 

(5). 

3.3.6.    ũɚɩůůŮɠ (Languages) 
 

Ƀɘ ɔɚɩůůŮɠ ŮɑɜŬɘ ɏɜŬ Ůɑŭɞɠ ŮˊɏəŰŬůɖɠ ˊɞɡ ŮɛűŬɜɑɕŮŰŬɘ əŬɘ ůŰɞ Frontend ŬɚɚɎ 

əŬɘ ůŰɞ Backend ŰɛɐɛŬ Űɞɡ Joomla. 

 

3.4.     ȺɔəŬŰɎůŰŬůɖ ŬɟɢŮɑɤɜ  ůŰɞ ˊŮɟɘɓɎɚɚɞɜ Űɞɡ Joomla 

 
ũɘŬ Űɖɜ ŮɔəŬŰɎůŰŬůɖ ŬɟɢŮɑɤɜ ůŰɞ Joomla Ŭˊɧ Űɖɜ ˊŮɟɘɞɢɐ ŭɘŬɢŮɑɟɘůɖɠ Űɞɡ Joomla 

ůŰɖ ɔɟŬɛɛɐ ɀŮɜɞɨ, ŮˊɘɚɏɔɞɡɛŮ Extensions > Manage > Install ɧˊɤɠ ŭŮɑɢɜŮɘ ɖ 

ˊŬɟŬəɎŰɤ ŮɘəɧɜŬ 14. 

 

ɳʽˁˈ˄ʰ мп  ɳʴˁʰˍʱˋˍʰˋʹ ʰˊ˔ʶʾ˖˄ ˋˍˇ ̄ ʶˊʽʲʱ˂˂ˇ˄ ˍˇˎ Joomla 

ȷˊɧ Űɖɜ Ůˊɘɚɞɔɐ Upload Package File, ŮˊɘɚɏɔɞɡɛŮ Űɞ əɞɡɛˊɑ Ⱥˊɘɚɞɔɐ ŬɟɢŮɑɞɡ, 

ŮˊɘɚɏɔɞɡɛŮ Űɞ ŬɟɢŮɑɞ ˊɞɡ ŮˊɘɗɡɛɞɨůŬɛŮ Ŭˊɧ Űɞɜ ɡˊɞɚɞɔɘůŰɐ ɛŬɠ ɤɠ ŮˊɏəŰŬůɖ .zip 

əŬɘ ˊŬŰɎɛŮ Űɞ əɞɡɛˊɑ Upload & Install. ȼ ŮˊɘŰɡɢɐɠ ŮɔəŬŰɎůŰŬůɖ Űɞɡ ŬɟɢŮɑɞɡ ůŰɞ 

ˊŮɟɘɓɎɚɚɞɜ Űɞɡ Joomla ŮˊɘɓŮɓŬɘɩɜŮŰŬɘ ɛŮ ůɢŮŰɘəɧ ɛɐɜɡɛŬ. 
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ȾȺūȷȿȷȽɃ 4 

ȾŬŰŬůəŮɡɐ ɘůŰɞůŮɚɑŭŬɠ 

4.1.    ȺɔəŬŰɎůŰŬůɖ Template 

ũɘŬ ɜŬ ŭɖɛɘɞɡɟɔɐůɞɡɛŮ Űɖɜ ɘůŰɞůŮɚɑŭŬ ɛŬɠ ɢɟɖůɘɛɞˊɞɘɐůŬɛŮ ɏɜŬ Ŭˊɧ ŰŬ ŭɤɟŮɎɜ 

ˊŬɟŮɢɧɛŮɜŬ ˊɟɧŰɡˊŬ (Templates) Űɞ ɞˊɞɑɞ Űɞ ŬɜŬɕɖŰɐůŬɛŮ ůŰɞ ŭɘŬŭɑəŰɡɞ  

ȼ Ůˊɘɚɞɔɐ Ůɜɧɠ ˊɟɞŰɨˊɞɡ, ɛɏůŬ Ŭˊɧ ɢɘɚɘɎŭŮɠ ˊɟɧŰɡ́Ŭ ˊɞɡ ɏɢɞɡɜ ŭɖɛɘɞɡɟɔɖɗŮɑ 

əŬɘ ɓɟɑůəɞɜŰŬɘ ŮɨəɞɚŬ ŬɜŬɕɖŰɩɜŰŬɠ Templates for Joomla ůŰɞ ŭɘŬŭɑəŰɡɞ, ɔɘŬ 

ŭɖɛɘɞɡɟɔɑŬ ɘůŰɞůŮɚɑŭŬɠ, ŮɑɜŬɘ ˊɟɞűŬɜɩɠ ŭɘəŬɑɤɛŬ Űɞɡ əŬŰŬůəŮɡŬůŰɐ Űɖɠ 

ɘůŰɞůŮɚɑŭŬɠ.  

ɇŬ ŭɤɟŮɎɜ ˊŬɟŮɢɧɛŮɜŬ ˊɟɧŰɡˊŬ ɏɢɞɡɜ ɞɟɘůɛɏɜŬ ɛŮɘɞɜŮəŰɐɛŬŰŬ ɧˊɤɠ: 

Å     Ƀ ŭɖɛɘɞɡɟɔɧɠ Űɞɡɠ ŭŮɜ ŭɑɜŮɘ ɡˊɞůŰɐɟɘɝɖ ɔɘŬ Űɞ ˊɟɧŰɡˊɞ, ŭɖɚŬŭɐ Ŭɜ Űɞɡ 

ůŰŮɑɚɞɡɛŮ ɛɐɜɡɛŬ ɔɘŬ əɎˊɞɘŬ ŬˊɞɟɑŬ ůɢŮŰɘəɎ ɛŮ Űɞ ˊɟɧŰɡˊɞ, ɛˊɞɟŮɑ əŬɘ ɜŬ 

ɛɖɜ ɛŬɠ ŬˊŬɜŰɐůŮɘ. 

Å     Ɇɡɜɐɗɤɠ ŭŮɜ ɏɢɞɡɜ ˊɞɚɚɏɠ ɗɏůŮɘɠ ɔɘŬ Modules. 

Å     Ⱥˊɑůɖɠ ɛˊɞɟŮɑ ɜŬ ɛɖɜ ɚŮɘŰɞɡɟɔɞɨɜ ůŮ ɧɚɞɡɠ Űɞɡɠ Browsers. ȰɜŬ ŭɤɟŮɎɜ 

ˊɟɧŰɡˊɞ ɔɘŬ ˊŬɟɎŭŮɘɔɛŬ ɜŬ ɚŮɘŰɞɡɟɔŮɑ ůŰɞɜ Google Chrome əŬɘ ɜŬ ɛɖɜ 

ɚŮɘŰɞɡɟɔŮɑ ůŰɞɜ Internet Explorer. 

ɇŬ ŮɛˊɞɟɘəɎ ŬɜŰɘɗɏŰɤɠ ɏɢɞɡɜ əɎˊɞɘɞ əɧůŰɞɠ ŬɔɞɟɎɠ, ŬɚɚɎ ŭɘŬɗɏŰɞɡɜ ɡˊɞůŰɐɟɘɝɖ 

Ŭˊɧ Űɞɜ əŬŰŬůəŮɡŬůŰɐ, ŮɑɜŬɘ ˊɟɞůŬɟɛɞůɛɏɜŬ ŬɜɎɚɞɔŬ ɛŮ Űɖɜ ŮűŬɟɛɞɔɐ ůŰɖɜ ɞˊɞɑŬ 

ɗŬ ŬɜŬűɏɟŮŰŬɘ ɖ ɘůŰɞůŮɚɑŭŬ əŬɘ ŮɑɜŬɘ ůɢŮŭɘŬůɛɏɜŬ ɔɘŬ ɜŬ ɡˊɞůŰɖɟɑɕɞɜŰŬɘ ůɢŮŭɧɜ Ŭˊɧ 

Űɞ ůɨɜɞɚɞ Űɤɜ Browsers.   

ȸɏɓŬɘŬ ɡˊɎɟɢɞɡɜ əŬɘ ˊɞɚɨ əŬɚɎ ŭɤɟŮɎɜ ˊɟɧŰɡˊŬ. ȺɛŮɑɠ ůŰɖɜ ˊɟɞəŮɘɛɏɜɖ 

ˊŮɟɑˊŰɤůɖ ɢɟɖůɘɛɞˊɞɘɐůŬɛŮ Űɞ Helix3 Framework, Űɞ ɞˊɞɑɞ ɧˊɤɠ ŬɜŬűɏɟŬɛŮ ŮɑɜŬɘ 

ŭɤɟŮɎɜ əŬɘ Űɞ əŬŰŮɓɎůŬɛŮ Ŭˊɧ Űɖɜ ɘůŰɞůŮɚɑŭŬ joomshaper (6).  

ȷűɞɨ əŬŰɏɓŮɘ Űɞ Template ɛŮŰŬɓŬɑɜɞɡɛŮ ůŰɞ ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ Joomla 

ŮˊɘɚɏɔɞɡɛŮ Ŭɧ́ Űɖɜ ɔɟŬɛɛɐ ɀŮɜɞɨ Extensions > Manage > Install ɐ əŬŰŮɡɗŮɑŬɜ 

Extensions > Manage. ɄŬŰɎɛŮ Ⱥˊɘɚɞɔɐ ŬɟɢŮɑɞɡ ɔɘŬ ɜŬ ɓɟɞɨɛŮ əŬɘ ɜŬ ŮˊɘɚɏɝɞɡɛŮ Űɞ 

ŬɟɢŮɑɞ Űɞɡ Template , Űɞ ɞˊɞɑɞ ŮɑɜŬɘ ůŰɘɠ ɚɐɣŮɘɠ. ɄŬŰɎɛŮ ȯɜɞɘɔɛŬ əŬɘ əɎɜɞɡɛŮ click 

ůŰɞ əɞɡɛˊɑ  Upload & Install.  
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ȼ ŮɔəŬŰɎůŰŬůɖ Űɞɡ Template ɐŰŬɜ ŮˊɘŰɡɢɐɠ ŬɚɚɎ ŬɜɞɑɔɞɜŰŬɠ Űɖɜ əŮɜŰɟɘəɐ 

ůŮɚɑŭŬ ˊŬɟŬŰɖɟɞɨɛŮ ɧŰɘ ŭŮɜ ŮɛűŬɜɑůŰɖəŮ Űɞ Template ˊɞɡ ŬɜŮɓɎůŬɛŮ (ŭɖɚŬŭɐ Űɞ 

helix3) ɔɘŬŰɑ ŭŮɜ ŮɑɜŬɘ ɞɟɘůɛɏɜɞ ɤɠ default Template Űɖɠ ůŮɚɑŭŬɠ ɛŬɠ. 

ũɘŬ ɜŬ əŬŰŬůŰɑůɞɡɛŮ Űɞ helix3 default Template əŬɘ ɜŬ ŮɛűŬɜɘůŰŮɑ ůŰɞ Frontend 

ŰɛɐɛŬ ůŰɖɜ ˊŮɟɘɞɢɐ ŭɘŬɢŮɑɟɘůɖɠ Űɞɡ Joomla ŮˊɘɚɏɔɞɡɛŮ Extensions > Templates, 

ŮɛűŬɜɑɕɞɜŰŬɘ ɧɚŬ ŰŬ Templates ˊɞɡ ŮɑɜŬɘ ŮɔəŬŰŮůŰɖɛɏɜŬ, ŮɜŰɞˊɑɕɞɡɛŮ Űɞ helix3 əŬɘ 

Űɞ əɎɜŬɛŮ default. ɆŰɖ ůɡɜɏɢŮɘŬ ŬɜɞɑɔɞɡɛŮ Űɖɜ əŮɜŰɟɘəɐ ůŮɚɑŭŬ əŬɘ ˊŬɟŬŰɖɟɞɨɛŮ ɧŰɘ 

ŮɛűŬɜɑɕŮŰŬɘ Űɞ Template helix3. 

ȹŮɜ ɝŮɢɜɎɛŮ ɜŬ ŮɜŮɟɔɞˊɞɘɐůɞɡɛŮ Űɖɜ ŮɛűɎɜɘůɖ Űɤɜ ɗɏůŮɤɜ Űɞɡ Template ɛŬɠ ɔɘŬ 

Űɖɜ ŮɘůŬɔɤɔɐ ůŮ ŬɡŰɏɠ ŬɜŰɘəŮɘɛɏɜɤɜ ˊɞɡ ɢɟŮɘŬɕɧɛŬůŰŮ ɔɘŬ Űɖɜ ɘůŰɞůŮɚɑŭŬ (ȷrticles, 

ɀodules, Component, Plugins). ȺˊɘɚɏɔɞɡɛŮ Ŭˊɧ Űɞ ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ Joomla 

Extensions > Templates > Styles > Options əŬɘ ůŰɖɜ Ůˊɘɚɞɔɐ Preview Module 

Positions ŮɜŮɟɔɞˊɞɘɞɨɛŮ Űɞ Enabled ŬɜŰɑ Űɞɡ Disabled ˊɞɡ ˊɟɞɦˊɐɟɢŮ. 

ɆŰɞ Template ŮɛűŬɜɑůŰɖəŬɜ ŭɘɎűɞɟŬ ůŰɞɘɢŮɑŬ ɀŮɜɞɨ. ȺɛŮɑɠ əɟŬŰɐůŬɛŮ ɛɧɜɞ Űɞ 

ȼɃɀȺ Űɞɡ ɞˊɞɑɞɡ ŬɚɚɎɝŬɛŮ Űɞ ɧɜɞɛŬ Űɞɡ ůŮ ȷɅɉȽȾȼ əŬɘ ɧɚŬ ŰŬ ɡˊɧɚɞɘˊŬ ŰŬ 

ŬŮ́ɜŮɟɔɞˊɞɘɐůŬɛŮ ɔɘŬ ɜŬ ŭɖɛɘɞɡɟɔɐůɞɡɛŮ əŬɘɜɞɨɟɔɘŬ.  

 

4.2.    ȺɔəŬŰɎůŰŬůɖ Ůɚɚɖɜɘəɐɠ ɔɚɩůůŬɠ 
 

ɇɞ ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ Joomla ŮɑɢŮ ˊɟɞŮɔəŬŰŮůŰɖɛɏɜɖ Űɖɜ Ŭɔɔɚɘəɐ ɔɚɩůůŬ. 

ȺˊŮɘŭɐ ɖ ɘůŰɞůŮɚɑŭŬ ɛŬɠ ɗɏɚŬɛŮ ɜŬ ŮɛűŬɜɑɕŮŰŮ əŬɘ ůŰŬ ŮɚɚɖɜɘəɎ ŮɔəŬŰŬůŰɐůŬɛŮ əŬɘ 

Űɖɜ Ůɚɚɖɜɘəɐ ɔɚɩůůŬ. ȼ ˊɞɟŮɑŬ ˊɞɡ ŬəɞɚɞɡɗɐůŬɛŮ ɔɘŬ ɜŬ ŮɔəŬŰŬůŰɐůɞɡɛŮ Űɖɜ 

Ůɚɚɖɜɘəɐ ɔɚɩůůŬ ŮɑɜŬɘ ɖ Ůɝɐɠ: ȷɟɢɘəɎ Ŭˊɧ Űɖɜ ˊŮɟɘɞɢɐ ŭɘŬɢŮɑɟɘůɖɠ Űɞɡ Joomla 

ŮˊɘɚɏɔɞɡɛŮ Extensions > Language(s) > Installed əŬɘ ŭɘŬˊɘůŰɩɜɞɡɛŮ ɧŰɘ ŮɑɜŬɘ 

ŮɔəŬŰŮůŰɖɛɏɜɖ ɛɧɜɞ ɖ Ŭɔɔɚɘəɐ ɔɚɩůůŬ. ɀŮŰŬɓŬɑɜɞɡɛŮ ůŰɞ MŮɜɞɨ Help > Joomla! 

Translations ɔɘŬ ɜŬ əŬŰŮɓɎůɞɡɛŮ Űɖɜ Ůɚɚɖɜɘəɐ ɔɚɩůůŬ. ɀŬɠ ŮɛűŬɜɑɕŮŰŬɘ ɖ ŮɘəɧɜŬ 15 

əŬɘ ŮˊɘɚɏɔɞɡɛŮ Űɖɜ ˊɟɩŰɖ ɏəŭɞůɖ, ɔɘŬŰɑ Űɞ Joomla ɛŬɠ ŮɑɜŬɘ ůɡɛɓŬŰɧ ɛŮ Űɖɜ ɏəŭɞůɖ 

3.x. 
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ɳʽˁˈ˄ʰ 15  ɳʴˁʰˍʱˋˍʰˋʹ ʶ˂˂ʹ˄ʽˁʺˌ ʴ˂˗ˋˋʰˌ ʶˉʽ˂ʷʴˇ˄ˍʰˌ ˍʹ˄ ˋˎ˃ʲʰˍʺ ʷˁʵˇˋʹ ʴʽʰ ˍˇ Joomla 

ɀŮŰɎ Űɖɜ Ůˊɘɚɞɔɐ ŮɛűŬɜɑɕŮŰŬɘ ɖ ůŮɚɑŭŬ ɛŮ Űɘɠ ŭɘŬɗɏůɘɛŮɠ ɔɚɩůůŮɠ. ũɘŬ 

ŭɘŮɡəɧɚɡɜůɖ ŬɜŬɕɐŰɖůɖɠ Űɖɠ Ůɚɚɖɜɘəɐ ɔɚɩůůŬɠ ˊŬŰɎɛŮ control+f  ɩůŰŮ ɜŬ ɛŬɠ 

ɓɔɎɚŮɘ ˊŬɟɎɗɡɟɞ ŬɜŬɕɐŰɖůɖɠ Ɏ́ɜɤ ŭŮɝɘɎ ůŰɞ ɞˊɞɑɞ ˊɚɖəŰɟɞɚɞɔɞɨɛŮ greek əŬɘ ɛŮŰɎ 

ˊŬŰɎɛŮ enter. ɆŰɖɜ ůɡɜɏɢŮɘŬ ŮˊɘɚɏɔɞɡɛŮ Űɞ link Űɞ ɞˊɞɑɞ ŮɑɜŬɘ əɎŰɤ Ŭˊɧ Űɞ 

Download Language Pack , ɧˊɤɠ ŭŮɑɢɜŮɘ ɖ ŮɘəɧɜŬ 16. 

  

ɳʽˁˈ˄ʰ мс  ɳˉʽ˂ˇʴʺ ˍˇˎ ˉʰˁʷˍˇˎ ˍʹˌ ʶ˂˂ʹ˄ʽˁʺ ʴ˂˗ˋˋʰˌ 

 

ɆŰɖɜ ůŰɐɚɖ Filename Űɖɠ ůŮɚɑŭŬɠ ˊɞɡ ŮɛűŬɜɑɕŮŰŬɘ ŮˊɘɚɏɔɞɡɛŮ Űɖɜ ˊɟɩŰɖ 

ɏəŭɞůɖ əŬɘ ɛŮ Download  ˊŮɟɘɛɏɜɞɡɛŮ ɜŬ əŬŰɏɓŮɘ Űɞ ŬɟɢŮɑɞ. 

ȳŰŬɜ ɖ ɚɐɣɖ Űɞɡ ŬɟɢŮɑɞɡ Űɖɠ ɔɚɩůůŬɠ ɞɚɞəɚɖɟɤɗŮɑ ŮˊɘɚɏɔɞɡɛŮ ůŰɖɜ 

ˊŮɟɘɞɢɐ ŭɘŬɢŮɑɟɘůɖɠ Extensions >   Manage > Install (ɐ ŬˊɚɎ Extensions > Manage). 
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ɆŰɖ ůŮɚɑŭŬ ˊɞɡ ŮɛűŬɜɑɕŮŰŬɘ ŮˊɘɚɏɔɞɡɛŮ Choose File əŬɘ Ŭűɞɨ ŮɜŰɞˊɑůɞɡɛŮ 

ůŰɘɠ ɚɐɣŮɘɠ Űɞ ŬɟɢŮɑɞ el-GR_joomla_lang_full_3.6.3v2.zip Űɖɠ Ůɚɚɖɜɘəɐɠ ɔɚɩůůŬɠ 

ˊŬŰɎɛŮ ɎɜɞɘɔɛŬ ɧˊɤɠ ŭŮɑɢɜŮɘ ɖ ŮɘəɧɜŬ 17. 

 

ɳʽˁˈ˄ʰ м7  ɮ˄ʷʲʰˋ˃ʰ ˍˇˎ ˉʰˁʷˍˇˎ ˍʹˌ ʶ˂˂ʹ˄ʽˁʺˌ ʴ˂˗ˋˋʰˌ ˋˍˇ Joomla 

 

ȺˊɘɚɏɔɞɡɛŮ Upload & Install, əŬɘ Űɞ ŬɟɢŮɑɞ ŮɔəŬɗɑůŰŬŰŬɘ ůŰɞ Joomla. ũɘŬ ɜŬ 

ŭɘŬˊɘůŰɩůɞɡɛŮ  ɧŰɘ Űɞ ŬɟɢŮɑɞ ŮɔəŬŰŬůŰɎɗɖəŮ ůŰɞ Joomla ŮˊɘɚɏɔɞɡɛŮ Extensions > 

Language > Installed əŬɘ ɖ Ůɚɚɖɜɘəɐ ɔɚɩůůŬ ŮɑɜŬɘ ˊŬɟɏŬ ɛŬɕɑ ɛŮ Űɖɜ Ŭɔɔɚɘəɐ. ȷɜ 

ŮˊɘɗɡɛɞɨɛŮ Űɞ ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ Joomla ɜŬ ŮɛűŬɜɑɕŮŰŬɘ ůŰŬ ȺɚɚɖɜɘəɎ ůŰɖɜ 

əɡɚɘɧɛŮɜɖ ɛˊɎɟŬ Site ŮˊɘɚɏɔɞɡɛŮ Administrator.  
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ɳʽˁˈ˄ʰ му  ɮˉˈ ˍʹ˄ ˁˎ˂ʽˈ˃ʶ˄ʹ ˃ˉʱˊʰ  ʶˉʽ˂ʷʴˇˎ˃ʶ Administrator 

 

ɆŰɖɜ ŮɘəɧɜŬ ˊɞɡ ŮɛűŬɜɑɕŮŰŬɘ ŮˊɘɚɏɔɞɡɛŮ Set default Űɖɜ Ůɚɚɖɜɘəɐ ɔɚɩůůŬ. 

ȷɡŰɧɛŬŰŬ ˊŬɟŬŰɖɟɞɨɛŮ ɧŰɘ ɖ ˊŮɟɘɞɢɐ ŭɘŬɢŮɑɟɘůɖɠ Űɞɡ Joomla ŮɛűŬɜɑɕŮŰŬɘ ůŰŬ 

ȺɚɚɖɜɘəɎ.  

 

ɳʽˁˈ˄ʰ 19  ɳˉʽ˂ˇʴʺ ʶ˂˂ʹ˄ʽˁʺˌ ʴ˂˗ˋˋʰˌ 

 

4.3.    ȺɔəŬŰɎůŰŬůɖ JCE Editor  
 

ɇɞ Joomla ŭɘŬɗɏŰŮɘ əŮɘɛŮɜɞɔɟɎűɞ ɔɘŬ Űɖɜ ŭɖɛɘɞɡɟɔɑŬ Ɏɟɗɟɤɜ ůŰɖɜ 

ɘůŰɞůŮɚɑŭŬ ɛŬɠ Űɞɜ Ⱥditor ï TinyMCE. ȳɛɤɠ ɏɢɞɡɛŮ Űɖɜ ŭɡɜŬŰɧŰɖŰŬ ɜŬ ŮˊɘɚɏɝɞɡɛŮ 

ɏɜŬɜ əŬɚɨŰŮɟɞ əŮɘɛŮɜɞɔɟɎűɞ ɛŮ ˊŮɟɘůůɧŰŮɟŬ ŮɟɔŬɚŮɑŬ əŬɘ ˊŮɟɘůůɧŰŮɟŮɠ 
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ŭɡɜŬŰɧŰɖŰŮɠ, ɩůŰŮ ɜŬ ŭɘŮɡəɞɚɡɜɗɞɨɛŮ ůŮ əŬɚɨŰŮɟɖ ˊŬɟɞɡůɑŬůɖ Űɤɜ Ɏɟɗɟɤɜ. O 

Editor ́ ɞɡ əŬŰŮɓɎůŬɛŮ ŮɑɜŬɘ ɞ JCE Editor ˊɞɡ ŭɘŬŰɑɗŮŰŬɘ ŭɤɟŮɎɜ əŬɘ Űɞɜ əŬŰŮɓɎůŬɛŮ 

Ŭˊɧ Űɖɜ ɘůŰɞůŮɚɑŭŬ  JCE Editor (7). 

ȳŰŬɜ ɞɚɞəɚɖɟɤɗŮɑ ɖ ɚɐɣɖ Űɞɡ ŬɟɢŮɑɞɡ Űɞɡ JCE Editor ɛŮŰŬɓŬɑɜɞɡɛŮ ůŰɖɜ 

ˊŮɟɘɞɢɐ ŭɘŬɢŮɑɟɘůɖɠ Űɞɡ Joomla əŬɘ ŮˊɘɚɏɔɞɡɛŮ Extensions > Manage > Install ɔɘŬ 

Űɖɜ ŮɔəŬŰɎůŰŬůɖ Űɞɡ ůŰɖɜ ˊŮɟɘɞɢɐ ŭɘŬɢŮɑɟɘůɖɠ Űɞɡ Joomla. Ƀ JCE Editor 

ŮɔəŬŰŬůŰɎɗɖəŮ ŮˊɘŰɡɢɩɠ, ŬɚɚɎ ɔɘŬ ɜŬ Űɞɜ ɢɟɖůɘɛɞˊɞɘɐůɞɡɛŮ ɢɟŮɘɎɕŮŰŬɘ ɜŬ Űɞɜ 

ˊɟɞŮˊɘɚɏɝɞɡɛŮ ɤɠ Ŭɟɢɘəɧ əŮɘɛŮɜɞɔɟɎűɞ. ȺˊɘɚɏɔɞɡɛŮ System > Global Configuration 

əŬɘ Ŭˊɧ Űɞɡɠ ŮɔəŬŰŮůŰɖɛɏɜɞɡɠ Editors ůŰɖɜ Ůˊɘɚɞɔɐ Default Editor ŮˊɘɚɏɔɞɡɛŮ Űɞɜ 

JCE Editor ɤɠ Default ɧˊɤɠ űŬɑɜŮŰŬɘ ůŰɖɜ ŮɘəɧɜŬ 20. 

 

ɳʽˁˈ˄ʰ нл  ɳˏˊʶˋʹ ˍˇˎ W/9 9ŘƛǘƻǊ  

ȷəɞɚɞɨɗɤɠ ˊŬŰɎɛŮ Save & Close əŬɘ Ŭˊɧ Ůŭɩ əŬɘ ˊɏɟŬ ŰŬ ɎɟɗɟŬ ɛŬɠ ɗŬ 

ɔɟɎűɞɜŰŬɘ ɛŮ Űɞɜ JCE Editor.  

4.4.    ȹɖɛɘɞɡɟɔɑŬ Ɏɟɗɟɞɡ 
 

ũɘŬ ɜŬ ŭɖɛɘɞɡɟɔɐůɞɡɛŮ ɏɜŬ Ɏɟɗɟɞ ŬəɞɚɞɡɗɞɨɛŮ ŰŬ Ůɝɐɠ ŰɟɑŬ ɓɐɛŬŰŬ: 

Å ȹɖɛɘɞɡɟɔɑŬ ɛɑŬɠ əŬŰɖɔɞɟɑŬɠ ɔɘŬ Űɞ Ɏɟɗɟɞ. 

Å ɆɡɔɔɟŬűɐ Űɞɡ Ɏɟɗɟɞɡ. 

Å ȹɖɛɘɞɡɟɔɑŬ ůŰɞɘɢŮɑɞɡ ɀŮɜɞɨ ɔɘŬ Űɖɜ ŮɛűɎɜɘůɖ Űɞɡ Ɏɟɗɟɞɡ. 
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ȺɛŮɑɠ ůŰɖɜ ˊɟɩŰɖ ůŮɚɑŭŬ Űɘɠ ɘůŰɞůŮɚɑŭŬ ɛŬɠ ŭɖɛɘɞɡɟɔɐůŬɛŮ ŰɟɑŬ ɎɟɗɟŬ əŬɘ 

ɛɎɚɘůŰŬ ŰŬ ŮɛűŬɜɑůŬɛŮ Űɞ ɏɜŬ ŭɑˊɚŬ ůŰɞ Ɏɚɚɞ, ŭɖɚŬŭɐ ůŮ ŰɟŮɑɠ ůŰɐɚŮɠ.  

ȼ ŭɖɛɘɞɡɟɔɑŬ ɛɘŬɠ əŬŰɖɔɞɟɑŬɠ ɔɑɜŮŰŮ ɤɠ Ůɝɐɠ: ɆŰɞ ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ Joomla 

ŮˊɘɚɏɔɞɡɛŮ Content > Categories > New ɐ ŮˊɘɚɏɔɞɡɛŮ əŬŰŮɡɗŮɑŬɜ Content > 

Categories > Add New Category. 

ȺɛűŬɜɑɕŮŰŬɘ ɖ ŮɘəɧɜŬ 21 ůŰɖɜ ɞˊɞɑŬ ɕɖŰɎ ɜŬ ůɡɛˊɚɖɟɩůɞɡɛŮ ɏɜŬ ɧɜɞɛŬ (Title 

*). ȺɛŮɑɠ ŰŬ ŰɟɑŬ ɎɟɗɟŬ ˊɞɡ ŭɖɛɘɞɡɟɔɐůŬɛŮ ŰŬ ŮɜŰɎɝŬɛŮ ůŮ ɛɑŬ əŬŰɖɔɞɟɑŬ ɛŮ ɧɜɞɛŬ 

ȷɟɢɘəɐ. 

 

ɳʽˁˈ˄ʰ нм  ɲʹ˃ʽˇˎˊʴʾʰ ˃ʽʰˌ ˁʰˍʹʴˇˊʾʰˌ ˃ʶ ˈ˄ˇ˃ʰ ɮˊ˔ʽˁʺ 

ɆŰɞ ́Ůŭɑɞ Title * ˊɚɖəŰɟɞɚɞɔɞɨɛŮ ȷɟɢɘəɐ. Ⱥˊɑůɖɠ ŮɘůɎɔɞɡɛŮ əŬɘ ůŰɞ ˊŮŭɑɞ 

Alias ɏɜŬ ɣŮɡŭɩɜɡɛɞ ɛŮ ɧɜɞɛŬ arxiki ɏŰůɘ ɩůŰŮ ɖ Google ɜŬ ɛɖɜ ɓɎɚŮɘ ŬɡŰɧɛŬŰŬ ɏɜŬ 

default Ŭˊɧ ɛɧɜɖ Űɖɠ ˊɞɡ ŮɜŭŮɢɞɛɏɜɤɠ ɜŬ ŮɑɜŬɘ ɎůɢŮŰɞ ɛŮ ŬɡŰɧ ˊɞɡ ˊŮɟɘɔɟɎűŮɘ.  

ɇɘɠ ɎɚɚŮɠ Ůˊɘɚɞɔɏɠ Űɘɠ ŬűɐɜɞɡɛŮ ɤɠ ɏɢŮɘ əŬɘ ˊŬŰɎɛŮ Save & Close. 

ȼ ŮˊɘŰɡɢɐɠ ŬˊɞɗɐəŮɡůɖ Űɖɠ əŬŰɖɔɞɟɑŬɠ ȷɟɢɘəɐ ŮˊɘɓŮɓŬɘɩɜŮŰŬɘ ɛŮ ɛɐɜɡɛŬ. 

ũɘŬ ɜŬ ŭɖɛɘɞɡɟɔɐůɞɡɛŮ ɏɜŬ Ɏɟɗɟɞ Ŭˊɧ Űɞ ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ Joomla 

ŮˊɘɚɏɔɞɡɛŮ Content > Articles >   New ɐ əŬŰŮɡɗŮɑŬɜ Content > Articles > Add New 

Article. 

ȺɛűŬɜɑɕŮŰŬɘ ɖ  ŮɘəɧɜŬ 22. 
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ɳʽˁˈ˄ʰ 2н  ɲʹ˃ʽˇˎˊʴʾʰ ˁʰʽ ˋˎʴʴˊʰ˒ʺ ˍˇˎ ʾʵʽˇˎ ˍˇˎ ʱˊʻˊˇˎ 

ɆŰɖɜ əɡɚɘɧɛŮɜɖ ɛˊɎɟŬ Category *  ŮˊɘɚɏɔɞɡɛŮ ɤɠ əŬŰɖɔɞɟɑŬ Űɖɜ ȷɟɢɘəɐ. 

ɆŰɞ ˊŮŭɑɞ Title * , ŭɖɚŬŭɐ ůŰɞɜ ŰɑŰɚɞ Űɞɡ Ɏɟɗɟɞɡ, ŮɘůɎɔɞɡɛŮ Űɞ ɧɜɞɛŬ Űɞɡ 

Ɏɟɗɟɞɡ ˊɞɡ ɔɘŬ Űɞ ˊɟɩŰɞ ɛŬɠ Ɏɟɗɟɞ ŮɑɜŬɘ ȸɑɚŬ əŬɘ ɢɟɖůɘɛɞˊɞɘɩɜŰŬɠ ŰŬ ŮɟɔŬɚŮɑŬ Űɞɡ 

əŮɘɛŮɜɞɔɟɎűɞɡ ɔɟɎűɞɡɛŮ əŬɘ ɛɞɟűɞˊɞɘɞɨɛŮ Űɞ əŮɑɛŮɜɞ Űɞɡ Ɏɟɗɟɞɡ.  

ȼ ɗɏůɖ əŬɘ ɖ ɛɞɟűɐ ŮɛűɎɜɘůɖɠ Ůɜɧɠ Ɏɟɗɟɞɡ ůŮ ɛɑŬ ůŮɚɑŭŬ ŮɑɜŬɘ Ůˊɘɚɞɔɐ Űɞɡ 

ŭɖɛɘɞɡɟɔɞɨ Űɖɠ. ɆŮ ɞɟɘůɛɏɜŮɠ ůŮɚɑŭŮɠ Űɞ Ɏɟɗɟɞ ŮɛűŬɜɑɕŮŰŮ ɞɚɧəɚɖɟɞ əŬɘ ůŮ ɎɚɚŮɠ 

ŮɛűŬɜɑɕŮŰŬɘ ɛɏɟɞɠ ŬɡŰɞɨ, ɛŮ ˊŬɟŬˊɞɛˊɐ ɔɘŬ ŮɛűɎɜɘůɖ ɞɚɧəɚɖɟɞɡ Űɞɡ Ɏɟɗɟɞɡ. 

ȺˊŮɘŭɐ ŮɛŮɑɠ ůŰɖɜ ůŮɚɑŭŬ ɛŬɠ ɗɏɚɞɡɛŮ ɜŬ ŮɛűŬɜɑůɞɡɛŮ ŰɟɑŬ ɎɟɗɟŬ ɛŮɔɎɚɞɡ ɛŮɔɏɗɞɡɠ  

ŰŬɡŰɧɢɟɞɜŬ ůŮ ŰɟŮɘɠ ůŰɐɚŮɠ əŬɘ ɜŬ ŮɘůɎɔɞɡɛŮ űɤŰɞɔɟŬűɑŬ ůŮ əɎɗŮ Ɏɟɗɟɞ ŮˊɘɚɏɝŬɛŮ 

ɜŬ ŮɛűŬɜɑɕŮŰŬɘ ɛɏɟɞɠ Ŭˊɧ əɎɗŮ Ɏɟɗɟɞ ɛŮ ˊŬɟŬˊɞɛˊɐ ɔɘŬ ŮɛűɎɜɘůɖ ɞɚɧəɚɖɟɞɡ.  

ȷűɞɨ ɔɟŬűŮɑ Űɞ Ɏɟɗɟɞ ŰɞˊɞɗŮŰɞɨɛŮ Űɞɜ əɏɟůɞɟŬ ůŮ ůɖɛŮɑɞ, ɧˊɞɡ ŮɛŮɑɠ 

ŮˊɘɗɡɛɞɨɛŮ, ˊɞɡ ɢɤɟɑɕŮɘ Űɞ ɛɏɟɞɠ Űɞɡ Ɏɟɗɟɞɡ ˊɞɡ ɗŬ ŮɛűŬɜɑɕŮŰŬɘ ůŰɖɜ əŮɜŰɟɘəɐ 

ůŮɚɑŭŬ. ȺˊɘɚɏɔɞɡɛŮ ůŰɞ Űɏɚɞɠ Űɞɡ ˊŬɟŬɗɨɟɞɡ Űɞɡ Ɏɟɗɟɞɡ Ŭˊɧ ŰŬ ɏɝɘ əɞɡɛˊɘɎ ˊɞɡ 

ˊŮɟɘɚŬɛɓɎɜŮɘ ŮəŮɑɜɞ ˊɞɡ ɔɟɎűŮɘ ůŰŬ ŬɔɔɚɘəɎ Read More ɐ ˊɘɞ ŬˊɚɎ əɎɜɞɡɛŮ click 

ˊɎɜɤ Ŭˊɧ Űɞ Ɏɟɗɟɞ ůŰɞ ˊɟɞŰŮɚŮɡŰŬɑɞ ŮɟɔŬɚŮɑɞ Űɞɡ əŮɘɛŮɜɞɔɟɎűɞɡ Insert Read More.  

ȷəɞɚɞɨɗɤɠ ůŰɖɜ Ůˊɘɚɞɔɐ Options Űɞɡ əŮɘɛŮɜɞɔɟɎűɞɡ əŬɘ ůŰɞ ˊɟɞŰŮɚŮɡŰŬɑɞ 

ˊŮŭɑɞ ˊɞɡ ɚɏŮɘ Read More Text ˊɚɖəŰɟɞɚɞɔɞɨɛŮ Űɞ əŮɑɛŮɜɞ ñȹɘŬɓɎůŰŮ ˊŮɟɘůůɧŰŮɟŬò 

ɧˊɤɠ űŬɑɜŮŰŬɘ ůŰɖɜ ŮɘəɧɜŬ 23 əŬɘ ɏˊŮɘŰŬ ŮˊɘɚɏɔɞɡɛŮ Save & Close. 
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ɳʽˁˈ˄ʰ 23  ʃ˂ʹˁˍˊˇ˂ˈʴʹˋʹ ˍˇˎ ˁʶʽ˃ʷ˄ˇˎ ʵʽʰʲʱˋˍʶ ˉʶˊʽˋˋˈˍʶˊʰ ˋˍˇ ˉʶʵʾˇ Read More text 

ɇŬ ŮˊɧɛŮɜŬ ŭɨɞ ɎɟɗɟŬ ˊɞɡ ŭɖɛɘɞɡɟɔɐůŬɛŮ, Ŭəɟɘɓɩɠ ɛŮ Űɞɜ Űɟɧˊɞ ˊɞɡ 

ˊŮɟɘɔɟɎɣŬɛŮ ˊŬɟŬˊɎɜɤ, ɔɘŬ Űɖɜ ɑŭɘŬ ůŮɚɑŭŬ ŰŬ ŮɜŰɎɝŬɛŮ ůŰɖɜ ɑŭɘŬ əŬŰɖɔɞɟɑŬ ȷɟɢɘəɐ 

əŬɘ Űɞɡɠ ŭɩůŬɛŮ ɞɜɧɛŬŰŬ ñKing ůɞɡɑŰŬò əŬɘ ñɄɞɚɡŰŮɚɐɠ ůɞɡɑŰŬò.  

ūɡůɘəɎ ŰŬ ɎɟɗɟŬ ŰŬ ˊɐɟŬɛŮ Ŭˊɧ ɘůŰɞůŮɚɑŭŮɠ ɝŮɜɞŭɞɢŮɑɤɜ, ɛŮ ŭɘəɏɠ ɛŬɠ 

ŰɟɞˊɞˊɞɘɐůŮɘɠ əŬɘ ɛɎɚɘůŰŬ ŰŬ ˊŮɟɘůůɧŰŮɟŬ Ŭˊɧ Űɖɜ ɘůŰɞůŮɚɑŭŬ ionianvista (8).  

ũɘŬ ɜŬ ŮɛűŬɜɘůŰɞɨɜ ŰŬ ɎɟɗɟŬ ůŰɖɜ ɘůŰɞůŮɚɑŭŬ ɛŬɠ əŬɘ ɛɎɚɘůŰŬ ůŰɖɜ ˊɟɩŰɖ 

ůŮɚɑŭŬ ɛŬɠ Űɖɜ ȷɅɉȽȾȼ Ŭˊɧ Űɞ ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ Joomla ŮˊɘɚɏɔɞɡɛŮ Menus > Main 

Menu əɎɜɞɡɛŮ click ůŰɞ ůŰɞɘɢŮɑɞ ɀŮɜɞɨ ȷɅɉȽȾȼ əŬɘ ŮɛűŬɜɑɕŮŰŬɘ ɖ ŮɘəɧɜŬ 24. 
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ɳʽˁˈ˄ʰ 2п  ɳˉʽ˂ˇʴʺ ˋˍˇʽ˔ʶʾˇˎ ˃ʶ˄ˇˏ ɮʄʋɹɼɶ ʴʽʰ ˍʹ˄ ʶ˃˒ʱ˄ʽˋʹ ˍ˖˄ ʱˊʻˊ˖˄ ˃ʰˌ 

ɆŰɖɜ Ůˊɘɚɞɔɐ Details ůŰɞ ˊŮŭɑɞ Menu Item Type *  ŮˊɘɚɏɔɞɡɛŮ Select, ůŰɞ 

ˊŬɟɎɗɡɟɞ ˊɞɡ ŮɛűŬɜɑɕŮŰŬɘ ŮˊɘɚɏɔɞɡɛŮ Articles əŬɘ ŮɛűŬɜɑɕŮŰŬɘ ɖ ŮɘəɧɜŬ 25. 

 

ɳʽˁˈ˄ʰ 2р ɳˉʽ˂ˇʴʺ /ŀǘŜƎƻǊȅ .ƭƻƎ ɹ ʽʰ ˍʹ˄ ʶʽˋʰʴ˖ʴʺ ˍ˖˄ ʱˊʻˊ˖˄ ˋˍʹ˄ ʾʵʽʰ ˋʶ˂ʾʵʰ 

Ⱥ́ ɘɚɏɔɞɡɛŮ Category Blog ɩůŰŮ ɜŬ ŮɘůɎɔɞɡɛŮ ŰŬ ɎɟɗɟŬ ɛŬɠ ůŰɖɜ ɑŭɘŬ ůŮɚɑŭŬ. 

ɆŰɖɜ Ůˊɘɚɞɔɐ Choose a Category *  ŮˊɘɚɏɔɞɡɛŮ Űɖɜ əŬŰɖɔɞɟɑŬ ȷɟɢɘəɐ. 
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ũɘŬ Űɖɜ ŮɛűɎɜɘůɖ Űɤɜ Űɟɘɩɜ Ɏɟɗɟɤɜ ɛŬɠ Űɞ ɏɜŬ ŭɑˊɚŬ ůŰɞ Ɏɚɚɞ ůŮ ŰɟŮɑɠ 

ůŰɐɚŮɠ əŬɘ ɧɢɘ Űɞ ɏɜŬ əɎŰɤ Ŭˊɧ Űɞ Ɏɚɚɞ ŮˊɘɚɏɔɞɡɛŮ Űɞ Blog Layout əŬɘ 

ůɡɛˊɚɖɟɩɜɞɡɛŮ Űɘɠ Űɘɛɏɠ ůŰŬ ˊŬɟŬəɎŰɤ ˊŮŭɑŬ ɧˊɤɠ űŬɑɜŮŰŬɘ ůŰɖɜ ŮɘəɧɜŬ 26. 

 

ɳʽˁˈ˄ʰ нс  ʄˎʻ˃ʾˋʶʽˌ ˇˊʽˋ˃ʷ˄˖˄ ˉʶʵʾ˖˄ ˋˍˇ .ƭƻƎ [ŀȅƻǳǘ ʴʽʰ ˄ʰ ʶ˃˒ʰ˄ʽˋˍˇˏ˄ ˍʰ ʱˊʻˊʰ ˍˇ ʷ˄ʰ 

ʵʾˉ˂ʰ ˋˍˇ ʱ˂˂ˇ 

ɆŰɞ ˊŮŭɑɞ # Leading Articles ́ ɚɖəŰɟɞɚɞɔɞɨɛŮ 0, ɔɘŬŰɑ ɗɏɚɞɡɛŮ ɜŬ ɛɖɜ 

ˊŮɟɘɏɢŮɘ əŬɜɏɜŬ Ɏɟɗɟɞ ŮˊɘəŮűŬɚɑŭŬ, ůŰɞ ˊŮŭɑɞ # Intro Articles ˊɚɖəŰɟɞɚɞɔɞɨɛŮ 3, 

ɔɘŬŰɑ ɞ Ŭɟɘɗɛɧɠ Űɤɜ Ɏɟɗɟɤɜ ˊɞɡ ɗŬ ŮɛűŬɜɘůŰɞɨɜ ŮɑɜŬɘ ŰɟɑŬ əŬɘ ůŰɞ ˊŮŭɑɞ # Columns 

ˊɚɖəŰɟɞɚɞɔɞɨɛŮ 3, ɔɘŬŰɑ ɗɏɚɞɡɛŮ ŰŬ ɎɟɗɟŬ ɛŬɠ ɜŬ ŮɛűŬɜɘůŰɞɨɜ Űɞ ɏɜŬ ŭɑˊɚŬ ůŰɞ 

Ɏɚɚɞ ůŮ ŰɟŮɘɠ ůŰɐɚŮɠ əŬɘ ŮˊɘɚɏɔɞɡɛŮ Save & Close. 

4.4.1.   Image Gallery Module 

ȺˊŮɘŭɐ ŰŬ ɎɟɗɟŬ ɛŬɠ ŬűɞɟɞɨůŬɜ Ůˊɘɚɞɔɏɠ ŭɘŬɛɞɜɐɠ ůŰɞ ɝŮɜɞŭɞɢŮɑɞ ɛŬɠ ɗŬ 

ɗɏɚŬɛŮ ůŮ əɎɗŮ Ɏɟɗɟɞ ɜŬ ɛˊɞɟɞɨɛŮ ɜŬ ŮɛűŬɜɑɕɞɡɛŮ ɏɜŬ ůɨɜɞɚɞ Ŭˊɧ ŮɘəɧɜŮɠ ˊɞɡ ɗŬ 

Űɞ ˊŮɟɘɔɟɎűɞɡɜ ɔɘŬ ɜŬ ɏɢŮɘ ɞ ˊŮɚɎŰɖɠ ɛɑŬ ˊɚɐɟɖ ŮɘəɧɜŬ ɔɘŬ Űɘɠ ŬɜɏůŮɘɠ ˊɞɡ ɗŬ Űɞɡ 

ˊɟɞůűŮɟɗɞɨɜ. ũɘŬ ŬɡŰɧ ůŮ əɎɗŮ Ɏɟɗɟɞ əɎɜŬɛŮ ŮɘůŬɔɤɔɐ Ůɜɧɠ ɀodule ˊɞɡ ɛˊɞɟŮɑ ɜŬ 

ɢɟɖůɘɛɞˊɞɘɐůŮɘ Űɞ Joomla əŬɘ ɛɎɚɘůŰŬ ˊŬɟɏɢŮŰŮ ŭɤɟŮɎɜ, Űɞ Image Gallery Module. 

ɇɞ Image Gallery Module ŮɛűŬɜɑɕŮɘ ɏɜŬ ůɨɜɞɚɞ Ůɘəɧɜɤɜ ˊɞɡ ɓɟɑůəɞɜŰŬɘ ůŮ ɏɜŬ 

ŬɟɢŮɑɞ ɛŮ Ůˊɘɚɞɔɏɠ, ˊɟɞɖɔɞɨɛŮɜɖ, ŮˊɧɛŮɜɖ əŬɘ ɛŮɔɏɗɡɜůɖ ɛŮ ɏɜŬ əɚɘə. ȷɡŰɧ Űɞ 

Module Űɞ əŬŰŮɓɎůŬɛŮ Ŭˊɧ Űɖɜ ɘůŰɞůŮɚɑŭŬ Űɞɡ Joomla (1). ȷűɞɨ Űɞ əŬŰŮɓɎůɞɡɛŮ 

əŬɘ Űɞ ŮɔəŬŰŬůŰɐůɞɡɛŮ ůŰŬ Modules Űɞɡ Joomla ɛˊɞɟɞɨɛŮ ɜŬ ˊŬɟŬŰɖɟɐůɞɡɛŮ ɧŰɘ 

ɏɢŮɘ ŮɔəŬŰŬůŰŬɗŮɑ ŮˊɘŰɡɢɩɠ ŮˊɘɚɏɔɞɜŰŬɠ ůŰɞ ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ Joomla Extensions > 

Modules əŬɘ ɗŬ Űɞ ŭɞɨɛŮ ɛŮ Űɞ ɧɜɞɛɎ Űɞɡ. 
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ȺˊɘɚɏɝŬɛŮ ɜŬ űŰɘɎɝɞɡɛŮ ŬɟɢŮɑŬ Ůɘəɧɜɤɜ ɔɘŬ əɎɗŮ Ɏɟɗɟɞ Ŭˊɧ Űɘɠ ŮɘəɧɜŮɠ ˊɞɡ 

ŮˊɘɚɏɝŬɛŮ Ŭˊɧ ŭɘɎűɞɟŮɠ ɘůŰɞůŮɚɑŭŮɠ ɝŮɜɞŭɞɢŮɑɤɜ əŬɘ əɡɟɑɤɠ Ŭˊɧ Űɞ 

www.ionianvista.com (8). ȺˊŮɘŭɐ ɞɘ ŮɘəɧɜŮɠ ŭŮɜ ŮɑɢŬɜ Űɞ ɑŭɘɞ ɛɏɔŮɗɞɠ əŬɘ ŮɛŮɑɠ 

ɗɏɚŬɛŮ ɜŬ ŮɑɜŬɘ ɧɚŮɠ Űɞɡ ɑŭɘɞɡ ɛŮɔɏɗɞɡɠ ɔɘŬ ɜŬ ŮɛűŬɜɑɕɞɜŰŬɘ ɞɛɞɘɧɛɞɟűŬ ůŰɖɜ 

ůŮɚɑŭŬ ɛŬɠ ŮˊɘůəŮűɗɐəŬɛŮ Űɖɜ ɘůŰɞůŮɚɑŭŬ  www.simpleimageresizer.com (9) ̄ ˇˎ ʷ˔ʶʽ 

ˍ ̌ ɟ́ɧɔɟŬɛɛŬ Simple Image Resizer ɔɘŬ Ůɨəɞɚɖ ŭɘŬɢŮɑɟɘůɖ Űɤɜ Ůɘəɧɜɤɜ əŬɘ Űɘɠ 

ŮˊŮɝŮɟɔŬůŰɐəŬɛŮ ɏŰůɘ ɩůŰŮ ɜŬ ɏɢɞɡɜ ɧɚŮɠ Űɘɠ ɑŭɘŮɠ ŭɘŬůŰɎůŮɘɠ. 

ȷűɞɨ ɏɔɘɜŬɜ ɑŭɘɞ ɛɏɔŮɗɞɠ ɧɚŮɠ ɞɘ ŮɘəɧɜŮɠ ɗŬ ˊɟɏˊŮɘ ŰɩɟŬ ɜŬ Űɘɠ ŬɜŮɓɎůɞɡɛŮ 

ůŰɞ Joomla. ũɘŬ ɜŬ ŬɜŮɓɎůɞɡɛŮ ɛɑŬ ɖ ˊŮɟɘůůɧŰŮɟŮɠ ŮɘəɧɜŮɠ ůŰɞ ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ 

Joomla ŮˊɘɚɏɔɞɡɛŮ Content > Media. ɆŰɖɜ ůɡɜɏɢŮɘŬ ŭɖɛɘɞɡɟɔɞɨɛŮ ɏɜŬɜ űɎəŮɚɞ ɔɘŬ 

ɜŬ ŮɘůɎɔɞɡɛŮ Űɘɠ ŮɘəɧɜŮɠ. ȺˊɘɚɏɔɞɡɛŮ Űɞ button Create New Folder ˊɚɖəŰɟɞɚɞɔɞɨɛŮ 

Űɞ ɧɜɞɛŬ Űɞɡ űŬəɏɚɞɡ ůŰɖɜ ˊɟɞəŮɘɛɏɜɖ ˊŮɟɑˊŰɤůɖ the_villa əŬɘ ˊŬŰɎɛŮ Create 

Folder. ȼ ŮɘəɧɜŬ 27 ŭŮɑɢɜŮɘ Űɖɜ ŭɘŬŭɘəŬůɑŬ ŭɖɛɘɞɡɟɔɑŬɠ Űɞɡ űŬəɏɚɞɡ the_villa. 

  

ɳʽˁˈ˄ʰ н7  ɲʹ˃ʽˇˎˊʴʾʰ ˒ʰˁʷ˂ˇˎ  ˃ ʶ ˈ˄ˇ˃ʰ ǘƘŜψǾƛƭƭŀ 

  

ȾɎɜɞɡɛŮ click ůŰɞɜ űɎəŮɚɞ. ɇɩɟŬ ŮɑɛŬůŰŮ ůŮ ɗɏůɖ ɜŬ ŬɜŮɓɎůɞɡɛŮ Űɘɠ 

ŮɘəɧɜŮɠ ɛŬɠ ɔɘŬ Űɞ Ɏɟɗɟɞ BɑɚŬ. ȾɎɜɞɡɛŮ click ůŰɞ əɞɡɛˊɑ Upload, ˊŬŰɎɛŮ Ⱥˊɘɚɞɔɐ 

ŬɟɢŮɑɤɜ, ŮˊɘɚɏɔɞɡɛŮ Űɞɜ űɎəŮɚɞ ůŰɞɜ ɞˊɞɑɞ ŮɑɜŬɘ ŬˊɞɗɖəŮɡɛɏɜŮɠ ɞɘ ŮɘəɧɜŮɠ, ˊŬŰɎɛŮ 

ȯɜɞɘɔɛŬ əŬɘ Űɞ əɞɡɛˊɑ Start Upload əŬɘ ŭɘŬˊɘůŰɩɜɞɡɛŮ ɧŰɘ ɞɘ ŮɘəɧɜŮɠ ɏɢɞɡɜ 

ɛŮŰŬűŮɟɗŮɑ ůŰɞ űɎəŮɚɞ the_villa ɛŮ ŮˊɘŰɡɢɑŬ ɧˊɤɠ ŭŮɑɢɜŮɘ ɖ ŮɘəɧɜŬ 28. 
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ɳʽˁˈ˄ʰ н8  ɮ˄ʷʲʰˋ˃ʰ ʶʽˁˈ˄˖˄ ˋˍˇ˄ ˒ʱˁʶ˂ˇ the_villa 

ɄŬɟŬŰɖɟɞɨɛŮ ɧŰɘ əɎŰɤ  Ŭˊɧ Űɖɜ Ⱥˊɘɚɞɔɐ ŬɟɢŮɑɤɜ ɡˊɎɟɢŮɘ ŮˊɘůɐɛŬɜůɖ ɔɘŬ Űɞ 

ɛɏɔŮɗɞɠ Űɤɜ Upload files (Maximum Size: 10 MB). ɀˊɞɟɞɨɛŮ ɓɏɓŬɘŬ ɜŬ ŬɚɚɎɝɞɡɛŮ 

Űɞ ɛɏɔŮɗɞɠ ŬɡŰɧ ŮˊɘɚɏɔɞɜŰŬɠ Ŭˊɧ Űɞ ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ Joomla Components > JCE 

Editor >   Profiles > Default > Editor Parameters > Filesystem, ŬɚɚɎɕɞɡɛŮ Űɞ Upload 

file size (KB) ůŰɞ ŮˊɘɗɡɛɖŰɧ ɛɏɔŮɗɞɠ əŬɘ ˊŬŰɎɛŮ Save & Close. 

Ƀɘ ŮɘəɧɜŮɠ ɛŬɠ ŬˊɞɗɖəŮɨŰɖəŬɜ ŮˊɘŰɡɢɩɠ əŬɘ ŮɑɜŬɘ ŬˊɞɗɖəŮɡɛɏɜŮɠ ůŰɞ űɎəŮɚɞ 

images/the_villa, ɔɘŬŰɑ o űɎəŮɚɞɠ the_villa ŬɚɚɎ əŬɘ ɞˊɞɘɞůŭɐˊɞŰŮ űɎəŮɚɞɠ ˊɞɡ ɗŬ 

ŭɖɛɘɞɡɟɔɖɗŮɑ ůŰɖɜ Ůˊɘɚɞɔɐ Media ɗŬ ŬˊɞɗɖəŮɡŰŮɑ ůŰɞɜ űɎəŮɚɞ images. 

ȺˊɧɛŮɜɖ ŮɜɏɟɔŮɘŬ ɞ ɞɟɘůɛɧɠ Űɖɠ ɗɏůɖɠ ɛɏůŬ ůŰɞ Ɏɟɗɟɞ ˊɞɡ ɗŬ ŰɞˊɞɗŮŰɖɗŮɑ 

Űɞ Image Gallery Module. ȺˊɘɚɏɔɞɡɛŮ Űɞ Ɏɟɗɟɞ ȸɑɚŬ əŬɘ ůŰɖɜ ɗɏůɖ ɛŮŰɎ Űɖɜ ɛˊɎɟŬ 

óŭɘŬɓɎůŰŮ ˊŮɟɘůůɧŰŮɟŬô (ɔɘŬŰɑ ŮəŮɑ ɗɏɚɞɡɛŮ ɜŬ ŮɛűŬɜɑɕŮŰŬɘ Űɞ Module) 

ˊɚɖəŰɟɞɚɞɔɞɨɛŮ {loadposition villes}. ȷɡŰɐ ɖ ˊɟɧŰŬůɖ ɛɏůŬ ůŮ ŬɔəɨɚŮɠ ůɖɛŬɑɜŮɘ 

ɧŰɘ űɞɟŰɩɜŮŰŮ ɛɑŬ ɗɏůɖ ůŰɞ Ɏɟɗɟɞ ɛŮ ɧɜɞɛŬ villes. ȷəɞɚɞɨɗɤɠ ˊŬŰɎɛŮ Save  & 

Close ɧˊɤɠ űŬɑɜŮŰŬɘ ůŰɖɜ ŮɘəɧɜŬ 29. 
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ɳʽˁˈ˄ʰ 29  ʊˈˊˍ˖ˋʹ ʻʷˋʹˌ ϑloadposition villes} ˃ʷˋʰ ˋˍˇ ʱˊʻˊˇ ɰʾ˂ʰ 

ɇŮɚɘəɐ ŮɜɏɟɔŮɘŬ ɖ ŮɜŮɟɔɞˊɞɑɖůɖ Űɞɡ Image Gallery Module. ȷˊɧ Űɞ 

ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ  Joomla ŮˊɘɚɏɔɞɡɛŮ Extensions > Modules. ȷűɞɨ Űɞ ŮɜŰɞˊɑůɞɡɛŮ 

Űɞ ŮˊɘɚɏɔɞɡɛŮ əŬɘ əɎɜɞɜŰŬɠ Click ŮɛűŬɜɑɕŮŰŬɘ ɖ ŮɘəɧɜŬ 30.  

 

ɳʽˁˈ˄ʰ 30  ɳ˄ˍˇˉʽˋ˃ˈˌ ˍˇˎ Image Gallery Module ˁ ʰʽ ʰˉʰˊʰʾˍʹˍʶˌ ˊˎʻ˃ʾˋʶʽˌ ˍ˖˄ ˉʶʵʾ˖˄ ˍˇˎ ʴʽʰ 

ˍˇ ʱˊʻˊˇ ɰʾ˂ʰ 

ɆŰɞ ˊŮŭɑɞ Title *  ɞɟɑɕɞɡɛŮ Űɞ ɧɜɞɛŬ Űɞɡ Module óThe Villaô, ůŰɞ ˊŮŭɑɞ Show 

Title ŮˊɘɚɏɔɞɡɛŮ Űɞ Hide ɔɘŬ ɜŬ ɛɖɜ ŮɛűŬɜɘůŰŮɑ ɞ ŰɑŰɚɞɠ Űɞɡ Module, ůŰɞ ˊŮŭɑɞ 

Images folder ́ ɚɖəŰɟɞɚɞɔɞɨɛŮ images/the_villa (ŮɑɜŬɘ Űɞ path Űɞɡ űŬəɏɚɞɡ ˊɞɡ ŮɑɜŬɘ 
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ŬˊɞɗɖəŮɡɛɏɜŮɠ ɞɘ ŮɘəɧɜŮɠ) ůŰɞ ˊŮŭɑɞ Position ŮˊɘɚɏɔɞɡɛŮ Űɖɜ ɗɏůɖ Űɞɡ Module, ɖ 

ɞˊɞɑŬ ŮɑɜŬɘ ɖ villes, ɔɘŬŰɑ ŬɡŰɐ ŮɑɜŬɘ ɖ ɗɏůɖ ˊɞɡ űɞɟŰɩůŬɛŮ ůŰɞ Ɏɟɗɟɞ ȸɑɚŬ ɔɘŬ ɜŬ 

ŰɞˊɞɗŮŰɖɗŮɑ Űɞ Module . ȰˊŮɘŰŬ ůŰɖɜ Ůˊɘɚɞɔɐ Menu Assignment ůŰɞ ˊŮŭɑɞ Module 

Assignment ŮˊɘɚɏɔɞɡɛŮ Only the pages selected (ŭɖɚŬŭɐ ɜŬ ŮɛűŬɜɘůŰŮɑ ɛɧɜɞ ůŰɘɠ 

ŮˊɘɚŮɔɛɏɜŮɠ ůŮɚɑŭŮɠ) ŰůŮəɎɟɞɡɛŮ Űɖɜ ȷɅɉȽȾȼ, ůŰŬ ˊŮŭɑŬ Preview image width əŬɘ 

Preview image height ́ ɚɖəŰɟɞɚɞɔɞɨɛŮ ŮˊɘɗɡɛɖŰɏɠ Űɘɛɏɠ 500 əŬɘ 440 ŬɜŰɑůŰɞɘɢŬ əŬɘ 

ˊŬŰɎɛŮ Save & Close. 

ȷəɟɘɓɩɠ Űɖɜ ɑŭɘŬ ŭɘŬŭɘəŬůɑŬ ɗŬ əɎɜɞɡɛŮ əŬɘ ůŰŬ ɎɚɚŬ ŭɨɞ ɎɟɗɟŬ (King 

ůɞɡɑŰŬ, ɄɞɚɡŰŮɚɐɠ ůɞɡɑŰŬ) ɛŮ Űɖɜ ŭɘŬűɞɟɎ ŬɚɚɎɕɞɡɛŮ ŰŬ ɞɜɧɛŬŰŬ Űɤɜ ɗɏůŮɤɜ Űɤɜ 

Ɏɟɗɟɤɜ ůŮ king əŬɘ deluxe ŬɜŰɑůŰɞɘɢŬ, ŭɖɛɘɞɡɟɔɞɨɛŮ əŬɘɜɞɨɟɔɘɞɡɠ űŬəɏɚɞɡɠ ɛŮ 

əŬɘɜɞɨɟɔɘŮɠ űɤŰɞɔɟŬűɑŮɠ ɔɘŬ ŰŬ ɎɟɗɟŬ. ŭŮɜ ɢɟŮɘɎɕŮŰŬɘ ɜŬ ŮɔəŬŰŬůŰɐůɞɡɛŮ ɝŬɜɎ Űɞ 

Image Gallery Module. ȷˊɧ Űɞ ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ Joomla ůŰɖɜ Ůˊɘɚɞɔɐ Extensions > 

Modules > New ŮˊɘɚɏɔɞɡɛŮ Űɞɜ Űɨˊɞ Űɞɡ Module sigplus  SIGPLUS_DESCRIPTION 

ɧˊɤɠ ŭŮɑɢɜŮɘ ɖ ŮɘəɧɜŬ 31. 

 

ɳʽˁˈ˄ʰ 31  ɲʹ˃ʽˇˎˊʴʾʰ ˍ˖˄ ˎˉˇ˂ˇʾˉ˖˄ Image Gallery Modules ʁ ˉʽ˂ʷʴˇ˄ˍʰˌ ˍˇ˄ ˍˏˉˇ ˍˇˎ Module 

sigplus SIGPLUS_DESCRIPTION 
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4.4.2.    ȺɘůŬɔɤɔɐ Ůɘəɧɜɤɜ ůŮ ɎɟɗɟŬ. 

ɆŰŬ ɎɟɗɟŬ ɛˊɞɟɞɨɛŮ ɜŬ ŮɘůɎɔɞɡɛŮ ŮɘəɧɜŮɠ, ůŮ ŮˊɘɚŮɔɛɏɜŮɠ ɗɏůŮɘɠ əŬɘ 

ɛɎɚɘůŰŬ ɧůŮɠ ɗɏɚɞɡɛŮ. ȺɛŮɑɠ ŮˊɘɚɏɝŬɛŮ əŬɘ ɔɘŬ ŰŬ ŰɟɑŬ ɎɟɗɟŬ ɜŬ  ɓɎɚɞɡɛŮ ŮɘəɧɜŬ 

ŬɜɎɛŮůŬ ůŰɞɜ ŰɑŰɚɞ Űɞɡ Ɏɟɗɟɞɡ əŬɘ Űɞ Ɏɟɗɟɞ.  

ũɘŬ ŮɘůŬɔɤɔɐ ŮɘəɧɜŬɠ ůŰɞ Ɏɟɗɟɞ ȸɑɚŬ ŬɜɎɛŮůŬ ůŰɞɜ ŰɑŰɚɞ ȸɑɚŬ əŬɘ Űɞɡ 

əŮɘɛɏɜɞɡ Ŭˊɧ Űɞ ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ Joomla ŮˊɘɚɏɔɞɡɛŮ Content > Articles, Űɞ Ɏɟɗɟɞ 

ȸɑɚŬ, Űɖ ɗɏůɖ Űɞɡ Ɏɟɗɟɞɡ ˊɞɡ ɗŬ ŮɘůɎɔɞɡɛŮ Űɖɜ ŮɘəɧɜŬ əŬɘ əɎɜɞɡɛŮ click ůŰɞ 

ˊɚɐəŰɟɞ Űɞɡ əŮɘɛŮɜɞɔɟɎűɞɡ Insert/Edit image. ȺˊɘɚɏɔɞɡɛŮ Ŭˊɧ ŬɟɢŮɑɞ Ůɘəɧɜɤɜ Űɖɜ 

ŮɘəɧɜŬ ˊɞɡ ɗɏɚɞɡɛŮ ɜŬ ŮɛűŬɜɘůŰŮɑ əŬɘ ˊŬŰɎɛŮ Insert ɧˊɤɠ ŭŮɑɢɜŮɘ ɖ ŮɘəɧɜŬ 32. 

 

ɳʽˁˈ˄ʰ 32  ɳˉʽ˂ˇʴʺ ˃ʽʰˌ ʰˉ˂ʺˌ ʶʽˁˈ˄ʰˌ ˁʰʽ ʶʽˋʰʴ˖ʴʺ ˍʹˌ ˋˍˇ ʱˊʻˊˇ ɰʾ˂ʰ 

 

ɀŮ Űɖɜ Ůˊɘɚɞɔɐ Űɖɠ ŮɘəɧɜŬɠ ŬɜŬɔɟɎűŮŰŬɘ ŬɡŰɧɛŬŰŬ Űɞ path Űɖɠ ůŰɞ ˊŮŭɑɞ 

URL. ɆŰɞ ́Ůŭɑɞ Alternative Text ɔɟɎűɞɡɛŮ ɏɜŬ əŮɑɛŮɜɞ ˊɞɡ ɗŬ ŮˊɘɗɡɛɞɨůŬɛŮ ɜŬ ɛŬɠ 

ŮɛűŬɜɑůŮɘ ůŮ ˊŮɟɑˊŰɤůɖ ˊɞɡ ŭŮɜ ɓɟŮɗŮɑ ɖ ŮɘəɧɜŬ, ůŰɞ ˊŮŭɑɞ Dimensions ŮɘůɎɔɞɡɛŮ 

Űɘɠ ŭɘŬůŰɎůŮɘɠ Űɖɠ ŮɘəɧɜŬɠ, ůŰɞ ˊŮŭɑɞ Alignment ŮˊɘɚɏɔɞɡɛŮ Centre (ɔɘŬ ŮɛűɎɜɘůɖ Űɖɠ 

ŮɘəɧɜŬɠ ůŰɞ əɏɜŰɟɞ Űɞɡ Ɏɟɗɟɞɡ ˊɎɜɤ Ŭˊɧ Űɞ əŮɑɛŮɜɞ) əŬɘ ˊŬŰɎɛŮ Insert. ȰˊŮɘŰŬ 

ˊŬŰɎɛŮ Save & Close.   
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ȷəɟɘɓɩɠ Űɖɜ ɑŭɘŬ ŭɘŬŭɘəŬůɑŬ ŬəɞɚɞɡɗɞɨɛŮ ɔɘŬ ŮɘůŬɔɤɔɐ ŮɘəɧɜŬɠ ůŰŬ ɎɚɚŬ 

ŭɨɞ ɎɟɗɟŬ (King ůɞɡɑŰŬ, ɄɞɚɡŰŮɚɐɠ ůɞɡɑŰŬ). ɀŮ Űɖɜ ɞɚɞəɚɐɟɤůɖ Űɖɠ ŭɘŬŭɘəŬůɑŬɠ 

ůŰŬ ɎɚɚŬ ŭɨɞ ɎɟɗɟŬ ɖ əŮɜŰɟɘəɐ ɛŬɠ ůŮɚɑŭŬ ɏɢŮɘ Űɖɜ ˊŬɟŬəɎŰɤ ɛɞɟűɐ: 

 

ɳʽˁˈ˄ʰ 33 ɳ˃˒ʱ˄ʽˋʹ ˈ˂˖˄ ˍ˖˄ ʱˊʻˊ˖˄ ˋˍʹ˄ ˁʶ˄ˍˊʽˁʺ ˋʶ˂ʾʵʰ ˍˇ ʷ˄ʰ ʵʾˉ˂ʰ ˋˍˇ ʱ˂˂ˇ 

 

4.5.    Module JE Orbit SlideShow 

ɀɑŬ ˊɟɞůŮɔɛɏɜɖ ɘůŰɞůŮɚɑŭŬ ˊɟɏˊŮɘ ɜŬ ˊŮɟɘɏɢŮɘ ůŰɘɠ ůŮɚɑŭŮɠ Űɖɠ Sliders, 

ŭɖɚŬŭɐ ůŮ ŮˊɘɚŮɔɛɏɜŮɠ ɗɏůŮɘɠ Űɖɠ ůŮɚɑŭŬɠ ɜŬ ŮɜŬɚɚɎůůɞɜŰŬɘ ŮɘəɧɜŮɠ, ˊŮɟɘɞŭɘəɎ, 

əŮɑɛŮɜŬ, ŭɘŬűɖɛɑůŮɘɠ əɚ́. ɛŮ ŮˊɘɚŮɔɛɏɜɖ ɢɟɞɜɘəɐ ˊŮɟɑɞŭɞ ɛŮŰɟɖɛɏɜɖ ůŮ ms. ȺɛŮɑɠ 

ůŰɖɜ ɘůŰɞůŮɚɑŭŬ ɛŬɠ ɢɟɖůɘɛɞˊɞɘɐůŬɛŮ Slider ɔɘŬ ŮɜŬɚɚŬɔɐ űɤŰɞɔɟŬűɘɩɜ.  

ɈˊɎɟɢɞɡɜ ŭɘŬɗɏůɘɛŮɠ ŮˊŮəŰɎůŮɘɠ SlideShow əŬɘ ɛɎɚɘůŰŬ ŬɟəŮŰɏɠ ɞɘ ɞˊɞɑŮɠ 

ŭɘŬŰɑɗŮɜŰŬɘ ŭɤɟŮɎɜ ůŰɞ ŭɘŬŭɑəŰɡɞ əŬŰɎɚɚɖɚŮɠ ɔɘŬ Űɞ Joomla. ɆŰɖɜ ŭɘəɐ ɛŬɠ 

ɘůŰɞůŮɚɑŭŬ ɢɟɖůɘɛɞˊɞɘɐůŬɛŮ Űɞ Module JE Orbit SlideShow, Űɞ ɞˊɞɑɞ Űɞ 

əŬŰŮɓɎůŬɛŮ Ŭˊɧ Űɖɜ ɘůŰɞůŮɚɑŭŬ extensions (10). ȷűɞɨ Űɞ ˊɟɧɔɟŬɛɛŬ əŬŰɏɓŮɘ ůŰɘɠ 

ɚɐɣŮɘɠ Űɞ ŮɔəŬɗɘůŰɞɨɛŮ ůŰŬ Modules Űɞɡ Joomla ɛŮ ŭɘŬŭɘəŬůɑŬ ˊɞɡ  ɏɢɞɡɛŮ 

ŬɜŬɚɡŰɘəɎ ˊŮɟɘɔɟɎɣŮɘ ůŮ ˊɟɞɖɔɞɨɛŮɜŮɠ ŮɔəŬŰŬůŰɎůŮɘɠ ˊɟɞɔɟŬɛɛɎŰɤɜ. ȷəɞɚɞɨɗɤɠ 

ŭɖɛɘɞɡɟɔɐůŬɛŮ ɏɜŬɜ űɎəŮɚɞ ɛŮ űɤŰɞɔɟŬűɑŮɠ Űɘɠ ɞˊɞɑŮɠ ɗɏɚɞɡɛŮ ɜŬ ŮɛűŬɜɑɕŮɘ ɞ 

Slider (ůŰɖɜ ˊŮɟɑˊŰɤůɐ ɛŬɠ Űɞɜ ɞɜɞɛɎůŬɛŮ change) əŬɘ Űɞɜ ŮɔəŬŰŬůŰɐůŬɛŮ ůŰɞ 

Content  > Media. 
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ũɘŬ Űɘɠ ɟɡɗɛɑůŮɘɠ Űɞɡ  Module JE Orbit SlideShow Ŭˊɧ Űɞ ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ 

Joomla ŮˊɘɚɏɔɞɡɛŮ Extensions > Modules   JE Orbit SlideShow əŬɘ ŮɛűŬɜɑɕŮŰŬɘ  

ŮɘəɧɜŬ 34. 

 

ɳʽˁˈ˄ʰ 34  ɳ˄ˍˇˉʽˋ˃ˈ ˍˇˎ  Module JE Orbit SlideShow ˁ ʰʽ ˊˏʻ˃ʽˋʹ ˍ˖˄ ʶˉʽ˂ˇʴ˗˄ ˍˇˎ 

ɇɞ ˊŮŭɑɞ Title *  Űɞ ŬűɐɜɞɡɛŮ ɤɠ ɏɢŮɘ JE Orbit SlideShow, ůŰɞ ˊŮŭɑɞ Show 

Title ŮˊɘɚɏɔɞɡɛŮ ȼide ɔɘŬŰɑ ŭŮɜ ɢɟŮɘɎɕŮŰŬɘ  ɜŬ ŮɛűŬɜɑɕŮŰŬɘ ɞ ŰɑŰɚɞɠ, ůŰɞ ˊŮŭɑɞ 

Position ŮˊɘɚɏɔɞɡɛŮ ɛɑŬ ɗɏůɖ ůŰɞ Template ɔɘŬ Űɞ Module, ůŰɞ ́Ůŭɑɞ Timer Speed 

ˊɚɖəŰɟɞɚɞɔɞɨɛŮ 2000, ɖ ŮˊɘɗɡɛɖŰɐ ŭɘɎɟəŮɘŬ ŮɛűɎɜɘůɖɠ ɛɘŬɠ ŮɘəɧɜŬɠ 2s əŬɘ ůŰɞ 

ˊŮŭɑɞ Animation Speed ́ ɚɖəŰɟɞɚɞɔɞɨɛŮ 1000, ˊɞɡ ůɖɛŬɑɜŮɘ ɧŰɘ ɛŮ Űɞ ˊɞɡ  ɗŬ 

ůŰŬɛŬŰɐůŮɘ ɖ ˊɟɩŰɖ ŮɘəɧɜŬ ɗŬ əɎɜŮɘ ˊŬɨůɖ 1s ɔɘŬ ɜŬ ŮɛűŬɜɘůŰŮɑ ɖ ŮˊɧɛŮɜɖ. ȰˊŮɘŰŬ 

ůŰɖɜ Ůˊɘɚɞɔɐ >>> Manage Slides <<< ŮˊɘɚɏɔɞɡɛŮ Űɘɠ ŮɘəɧɜŮɠ əŬɘ Űɞ ˊɚɐɗɞɠ Űɤɜ 

Ůɘəɧɜɤɜ ˊɞɡ ɗɏɚɞɡɛŮ ɜŬ ŮɛűŬɜɑɕŮɘ Űɞ Module. ȺɛŮɑɠ ŮˊɘɚɏɝŬɛŮ Űɘɠ 8 ŮɘəɧɜŮɠ ˊɞɡ 

ɓɟɑůəɞɜŰŬɘ ůŰɞɜ űɎəŮɚɞ /images/change ɧˊɤɠ űŬɑɜŮŰŬɘ ůŰɖɜ ŮɘəɧɜŬ 35. 
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ɳʽˁˈ˄ʰ 35  ɳˉ̔˂ˇʴʺ ˍ˖˄ ɳʽˁˈ˄˖˄ ˉˇˎ ʻʰ ʶ˃˒ʰ˄ʾˋʶʽ ˍˇ Module 

  

ɆŰɖɜ Menu Assignment ŮˊɘɚɏɝŬɛŮ On all pages ɔɘŬ ɜŬ ŮɛűŬɜɑɕŮŰŬɘ ůŮ ɧɚŮɠ Űɘɠ 

ůŮɚɑŭŮɠ Űɖɠ ɘůŰɞůŮɚɑŭŬɠ ɛŬɠ əŬɘ ˊŬŰɎɛŮ Save & Close. 

ɇŮɚɘəɎ ɖ ůŮɚɑŭŬ ɛŬɠ ŮɛűŬɜɑɕŮŰŬɘ ɧˊɤɠ ŭŮɑɢɜŮɘ ɖ ŮɘəɧɜŬ 36 ɧˊɞɡ 

ŮɜŬɚɚɎůůɞɜŰŬɘ ɞɘ űɤŰɞɔɟŬűɑŮɠ Űɞɡ űŬəɏɚɞɡ change. 

 

ɳʽˁˈ˄ʰ 36  ɳ˃˒ʱ˄ʽˋʹ ˍˇˎ aƻŘǳƭŜ ʅˍʹ˄ ˁʶ˄ˍˊʽˁʺ ˋʶ˂ʾʵʰ 
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4.6.   Ʉɟɞůɗɐəɖ ŰŮůůɎɟɤɜ ɔəŬɚŮɟɑ 

ũɘŬ ɜŬ ŮɛˊɚɞɡŰɑůɞɡɛŮ Űɖɜ ɘůŰɞůŮɚɑŭŬ ɛŬɠ ŮˊɘɚɏɝŬɛŮ ɜŬ ˊɟɞůɗɏůɞɡɛŮ ŬəɧɛŬ 

ŰɏůůŮɟŬ Image Gallery Module ůŮ ɎɚɚŮɠ ɗɏůɖɠ Űɞɡ Template. ȺˊɘɚɏɝŬɛŮ ɜŬ ɓɎɚɞɡɛŮ 

12 űɤŰɞɔɟŬűɑŮɠ Ŭˊɧ Űɞ ɝŮɜɞŭɞɢŮɑɞ əŬɘ ŮˊŮɘŭɐ ŰŬ Image Galleries ŮɑɜŬɘ ŰɏůůŮɟŬ ůŮ 

əɎɗŮ ɏɜŬ ɗŬ ɓɎɚɞɡɛŮ ɜŬ ŮɛűŬɜɑɕŮɘ ŰɟŮɘɠ ŮɘəɧɜŮɠ. ɈˊŮɜɗɡɛɑɕɞɡɛŮ ɧŰɘ ɧɚŮɠ Űɘɠ ŮɘəɧɜŮɠ 

Űɘɠ ɏɢɞɡɛŮ əɎɜŮɘ ɑŭɘɤɜ ŭɘŬůŰɎůŮɤɜ ɞˊɧŰŮ ɗŬ ɝŮəɘɜɐůɞɡɛŮ ɛŮ Űɞ ˊɟɩŰɞ Image Gallery. 

ȺˊɘɚɏɔɞɡɛŮ ɚɞɘˊɧɜ Ŭˊɧ Űɞ ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ Joomla Content > Media, ŭɖɛɘɞɡɟɔɞɨɛŮ 

ɏɜŬɜ űɎəŮɚɞ, ɧˊɤɠ ɏɢɞɡɛŮ ˊɟɞŬɜŬűɏɟŮɘ ůɢŮŰɘəɎ ɛŮ Űɖɜ ŭɖɛɘɞɡɟɔɑŬ Űɞɡ, ɛŮ ɧɜɞɛŬ 

gallery1 əŬɘ ŬɜŮɓɎɕɞɡɛŮ ŮəŮɑ Űɘɠ ŰɟŮɘɠ ˊɟɩŰŮɠ ŮɘəɧɜŮɠ ɛŬɠ. ȷəɞɚɞɨɗɤɠ ɛŮ Űɞɜ ɑŭɘɞ 

Űɟɧˊɞ ŭɖɛɘɞɡɟɔɞɨɛŮ Ɏɚɚɞɡɠ ŰɟŮɘɠ űŬəɏɚɞɡɠ gallery2, gallery3, gallery4 əŬɘ 

ŰɞˊɞɗŮŰɞɨɛŮ ůŮ ŬɡŰɞɨɠ ŰɟŮɘɠ űɤŰɞɔɟŬűɑŮɠ ůŰɞɜ əŬɗɏɜŬ. 

ȷˊɧ Űɞ ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ Joomla ŮˊɘɚɏɔɞɡɛŮ Extensions > Modules > New 

ɔɘŬ ɜŬ ŭɖɛɘɞɡɟɔɐůɞɡɛŮ ŭɘŬŭɞɢɘəɎ ŰŬ ŰɏůůŮɟŬ Image Galleries. ɆŰɞ ˊɟɩŰɞ ŭɑɜɞɡɛŮ 

ɧɜɞɛŬ sigplus_arxiki_0, Images folder Űɞɜ images/gallery1, ůŰɞ Show Title 

ŮˊɘɚɏɔɞɡɛŮ Hide, Position ɗɏůŬɛŮ bottom1, ůŰɖɜ Ůˊɘɚɞɔɐ Menu Assignment ůŰɞ 

Module Assignment ŮˊɘɚɏɔɞɡɛŮ Only the pages selected, ŮˊɘɚɏɔɞɡɛŮ Űɞ ůŰɞɘɢŮɑɞ 

MŮɜɞɨ ȷɅɉȽȾȼ əŬɘ ˊŬŰɎɛŮ  Save & Close. ɇŬ ůŰɞɘɢŮɑŬ ɔɘŬ Űɞ ˊɟɩŰɞ Image Gallery 

űŬɑɜɞɜŰŬɘ ůŰɖɜ ŮɘəɧɜŬ 37. 

   

ɳʽˁˈ˄ʰ 37 ɲʹ˃ʽˇˎˊʴʾʰ ˁʰʽ ˊˏʻ˃ʽˋʹ ˍˇˎ ˉˊ˗ˍˇˎ Image Gallery Module 
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ɆŰɞ ŭŮɨŰŮɟɞ ŭɑɜɞɡɛŮ ɧɜɞɛŬ sigplus_arxiki_1, Images folder Űɞɜ  

images/gallery2, ůŰɞ Show Title ŮˊɘɚɏɔɞɡɛŮ Hide, Position ɗɏŰɞɡɛŮ bottom2, ůŰɖɜ 

Ůˊɘɚɞɔɐ Menu Assignment ůŰɞ Module Assignment ŮˊɘɚɏɔɞɡɛŮ Only the pages 

selected, ŮˊɘɚɏɔɞɡɛŮ Űɞ ůŰɞɘɢŮɑɞ ɛŮɜɞɨ ȷɅɉȽȾȼ əŬɘ ˊŬŰɎɛŮ  Save & Close. ɇŬ 

ůŰɞɘɢŮɑŬ ɔɘŬ Űɞ ŭŮɨŰŮɟɞ Image Gallery űŬɑɜɞɜŰŬɘ ůŰɖɜ ŮɘəɧɜŬ 38. 

 

ɳʽˁˈ˄ʰ 38  ɲʹ˃ʽˇˎˊʴʾʰ ˁʰʽ ˊˏʻ˃ʽˋʹ ˍˇˎ ʵʶˏˍʶˊˇˎ Image Gallery Module 

ɆŰɞ ŰɟɑŰɞ ŭɑɜɞɡɛŮ ɧɜɞɛŬ sigplus_arxiki_2, Images folder Űɞɜ  

images/gallery3, ůŰɞ Show Title ŮˊɘɚɏɔɞɡɛŮ Hide, Position ɗɏŰɞɡɛŮ bottom3, ůŰɖɜ 

Ůˊɘɚɞɔɐ Menu Assignment ůŰɞ Module Assignment ŮˊɘɚɏɔɞɡɛŮ Only the pages 

selected, ŮˊɘɚɏɔɞɡɛŮ Űɞ ůŰɞɘɢŮɑɞ MŮɜɞɨ ȷɅɉȽȾȼ əŬɘ ˊŬŰɎɛŮ  Save & Close. ɇŬ 

ůŰɞɘɢŮɑŬ ɔɘŬ Űɞ ŰɟɑŰɞ Image Gallery űŬɑɜɞɜŰŬɘ ůŰɖɜ ŮɘəɧɜŬ 39. 

 

ɳʽˁˈ˄ʰ о9  ɲʹ˃ʽˇˎˊʴʾʰ ˁʰʽ ˊˏʻ˃ʽˋʹ ˍˇˎ ˍˊʾˍˇˎ Image Gallery Module 
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ɆŰɞ ŰŮɚŮɡŰŬɑɞ ŭɑɜɞɡɛŮ ɧɜɞɛŬ sigplus_arxiki_3, Images folder Űɞɜ  

images/gallery4, ůŰɞ Show Title ŮˊɘɚɏɔɞɡɛŮ Hide, Position ɗɏŰɞɡɛŮ bottom4, ůŰɖɜ 

Ůˊɘɚɞɔɐ Menu Assignment ůŰɞ Module Assignment ŮˊɘɚɏɔɞɡɛŮ Only the pages 

selected, ŮˊɘɚɏɔɞɡɛŮ Űɞ ůŰɞɘɢŮɑɞ MŮɜɞɨ ȷɅɉȽȾȼ əŬɘ ˊŬŰɎɛŮ  Save & Close. ɇŬ 

ůŰɞɘɢŮɑŬ ɔɘŬ Űɞ ŰɏŰŬɟŰɞ əŬɘ ŰŮɚŮɡŰŬɑɞ Image Gallery űŬɑɜɞɜŰŬɘ ůŰɖɜ ŮɘəɧɜŬ 40. 

 

ɳʽˁˈ˄ʰ 40 ɲʹ˃ʽˇˎˊʴʾʰ ˁʰʽ ˊˏʻ˃ʽˋʹ ˍˇˎ ˍʷˍʰˊˍˇˎ Image Gallery Module 

ȷɜŬɜŮɩɜɞɜŰŬɠ Űɖɜ ɘůŰɞůŮɚɑŭŬ ɛŬɠ ŮɛűŬɜɑɕɞɜŰŬɘ ŰŬ ŰɏůůŮɟŬ Image Galleries 

ɧˊɤɠ ŭŮɑɢɜŮɘ ɖ ŮɘəɧɜŬ 41. 

 

ɳʽˁˈ˄ʰ п1  ɳ˃˒ʱ˄ʽˋʹ ˈ˂˖˄ ˍ˖˄  Image Gallery Module ̀ ˍʹ˄ ˁʶ˄ˍˊʽˁʺ ˋʶ˂ʾʵʰ 
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 4.7.   ȹɖɛɘɞɡɟɔɑŬ Module ɛŮ Űɖɜ ɢɟɐůɖ Module Custom  HTML 
 

ȰɢɞɡɛŮ Űɖɜ ŭɡɜŬŰɧŰɖŰŬ ɜŬ ɔɟɎűɞɡɛŮ əŮɑɛŮɜŬ ˊɞɡ ɗɏɚɞɡɛŮ ɜŬ ŮɛűŬɜɑɕɞɜŰŬɘ 

ůŰɖɜ ɘůŰɞůŮɚɑŭŬ ɛŬɠ ɛŮ ɢɟɐůɖ Űɞɡ Module Custom HTML. ȷˊɧ Űɞ ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ 

Joomla ŮˊɘɚɏɔɞɡɛŮ Extensions  > Modules > New əŬɘ Ŭˊɧ Űɘɠ Ůˊɘɚɞɔɏɠ Űɞɡ Select a 

Module Type ŮˊɘɚɏɔɞɡɛŮ Custom. ŪŬ ŮɛűŬɜɘůŰŮɑ ɞ Editor ůŰɞɜ ɞˊɞɑɞ ɔɟɎűɞɡɛŮ Űɞ 

əŮɑɛŮɜɞ, ɧˊɤɠ ŭŮɑɢɜŮɘ ɖ ŮɘəɧɜŬ 42. 

   

ɳʽˁˈ˄ʰ п2  ɲʹ˃ʽˇˎˊʴʾʰ ˁʰʽ ˊˏʻ˃ʽˋʹ Module Custom HTML 

ɇɞ əŮɑɛŮɜɞ ˊɞɡ ɗɏɚɞɡɛŮ ɜŬ ŮɛűŬɜɘůŰŮɑ ŮɑɜŬɘ ɞɟɘůɛɏɜŮɠ ˊɚɖɟɞűɞɟɑŮɠ ůɢŮŰɘəɎ 

ɛŮ Űɖɜ ŮˊɘəɞɘɜɤɜɑŬ Űɞɡ ɝŮɜɞŭɞɢŮɑɞɡ ɛŬɠ. ȺɛŮɑɠ ɔɟɎɣŬɛŮ Űɞ əŮɑɛŮɜɞ ˊɞɡ ŬəɞɚɞɡɗŮɑ: 

ȺˊɘəɞɘɜɤɜɐůŰŮ ɛŬɕɑ ɛŬɠ. 

 ȾɤɜůŰŬɜŰɘɜɞɡˊɧɚŮɤɠ 10, ɄŮɟɘůŰɏɟɘ ï ɇ.Ⱦ 12132 

ɇɖɚɏűɤɜɞ: 2671025585 

Fax: 2671025585. 

Email: stbaliouskas@yahoo.gr 

ɆɡɛˊɚɖɟɩɜɞɡɛŮ ůŰɞ ˊŮŭɑɞ title *  ɏɜŬ ɧɜɞɛŬ .́ɢ ȹɘŮɨɗɡɜůɖ, ůŰɞ ˊŮŭɑɞ Show 

Title ŮˊɘɚɏɔɞɡɛŮ Hide, ŮˊŮɘŭɐ ŭŮɜ ɗɏɚɞɡɛŮ ɜŬ ŮɛűŬɜɑɕŮŰŮ ɞ ŰɑŰɚɞɠ, ůŰɞ ˊŮŭɑɞ Position 

Űɖɜ ɗɏůɖ footer1 Űɞɡ Template ɛŬɠ, ůŰɞ Menu Assignment  Module Assignment 

mailto:stbaliouskas@yahoo.gr
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ŮˊɘɚɏɔɞɡɛŮ On all pages əŬɘ ˊŬŰɎɛŮ Save & Close. ȾɎɜɞɜŰŬɠ ŬɜŬɜɏɤůɖ 

ˊŬɟŬŰɖɟɞɨɛŮ ɧŰɘ Űɞ əŮɑɛŮɜɞ ŮɛűŬɜɑůŰɖəŮ ɧˊɤɠ ɗɏɚŬɛŮ əŬɘ Űɞ ɓɚɏˊɞɡɛŮ ůŰɖɜ ȺɘəɧɜŬ 

43. 

 

 

ɳʽˁˈ˄ʰ 43  ɳ˃˒ʱ˄ʽˋʹ aƻŘǳƭŜ /ǳǎǘƻƳ I¢a[ ˋˍʹ˄ ˁʶ˄ˍˊʽˁʺ ˋʶ˂ʾʵʰ 

 

4.8.   Ʉɟɞůɗɐəɖ ɜɏɤɜ ůŰɞɘɢŮɑɤɜ ɛŮɜɞɨ. 

ɀɏɢɟɘ ŰɩɟŬ ɖ ɘůŰɞůŮɚɑŭŬ ɛŬɠ ˊŮɟɘɏɢŮɘ ɛɧɜɞ Űɞ ůŰɞɘɢŮɑɞ ɛŮɜɞɨ ȷɅɉȽȾȼ. ŪŬ 

ůɡɜŮɢɑůɞɡɛŮ ŭɖɛɘɞɡɟɔɩɜŰŬɠ  ɜɏŬ ŬˊŬɟŬɑŰɖŰŬ ůŰɞɘɢŮɑŬ ɛŮɜɞɨ ˊɞɡ ˊɟɏˊŮɘ ɜŬ ɏɢŮɘ ɖ 

ɘůŰɞůŮɚɑŭŬ ɛŬɠ. ȾɟɑɜŬɛŮ ŬˊŬɟŬɑŰɖŰɞ ɜŬ ůɡɛˊŮɟɘɚɎɓɞɡɛŮ ůŮ ŬɡŰɎ ŰŬ: 

Å ɄȷɅɃɉȺɆ 

Å ūɋɇɃũɅȷūȽȺɆ 

Å ȾɅȷɇȼɆȺȽɆ 

Å ɇɃɄɃŪȺɆȽȷ 

Å ȺɄȽȾɃȽɁɋɁȽȷ 

4.8.1.   Ʉɟɞůɗɐəɖ ůŰɞɘɢŮɑɞɡ ɛŮɜɞɨ ɄȷɅɃɉȺɆ. 
 

 ȳˊɤɠ ɏɢɞɡɛŮ ŬɜŬűɏɟŮɘ ɔɘŬ ɜŬ ŭɖɛɘɞɡɟɔɖɗŮɑ ɏɜŬ ůŰɞɘɢŮɑɞ ɀŮɜɞɨ ˊɟɏˊŮɘ 

ˊɟɩŰŬ ɜŬ ŭɖɛɘɞɡɟɔɐůɞɡɛŮ ɏɜŬ Ɏɟɗɟɞ. ɇɞ Ɏɟɗɟɞ Űɞ ŭɖɛɘɞɡɟɔɞɨɛŮ ůɨɛűɤɜŬ ɛŮ ɧůŬ 
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ɏɢɞɡɛŮ ŬɜŬűɏɟŮɘ ˊŬɟŬˊɎɜɤ. ȾŬŰŬɟɢɎɠ ŭɖɛɘɞɡɟɔɐůŬɛŮ ɛɑŬ əŬŰɖɔɞɟɑŬ ɛŮ ɧɜɞɛŬ 

ɄŬɟɞɢɏɠ əŬɘ ůŰɖɜ ůɡɜɏɢŮɘŬ ŭɖɛɘɞɡɟɔɐůŬɛŮ ɏɜŬ Ɏɟɗɟɞ ɛŮ ɧɜɞɛŬ ɄŬɟɞɢɏɠ əŬɘ Űɞ 

ŮɜŰɎɝŬɛŮ ůŰɖɜ əŬŰɖɔɞɟɑŬ ɄŬɟɞɢɏɠ. ɀŮŰɎ ŮɛűŬɜɑɕɞɡɛŮ Űɞ Ɏɟɗɟɞ ɛŬɠ. ȷˊɧ Űɞ 

ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ Joomla ŮˊɘɚɏɔɞɡɛŮ Menus > Main Menu əŬɘ ˊŬŰɎɛŮ New. ɆŰɞ 

Menu Title *  ˊɚɖəŰɟɞɚɞɔɞɨɛŮ Űɞ ɧɜɞɛŬ Űɞɡ ůŰɞɘɢŮɑɞɡ ɛŮɜɞɨ Űɞ ɄȷɅɃɉȺɆ, ůŰɞ 

Menu Item Type ŮˊɘɚɏɔɞɡɛŮ Single Article, ɔɘŬŰɑ ŰɩɟŬ ɗɏɚɞɡɛŮ ɏɜŬ Ɏɟɗɟɞ əŬɘ ɧɢɘ 

ˊŮɟɘůůɧŰŮɟŬ ɧˊɤɠ ˊɟɘɜ. ȺˊɘɚɏɔɞɡɛŮ Űɞ Ɏɟɗɟɞ əŬɘ ˊŬŰɎɛŮ Save & Close. 

ũɘŬ ɜŬ ŮɛˊɚɞɡŰɑůɞɡɛŮ Űɖɜ ůŮɚɑŭŬ ɄȷɅɃɉȺɆ ŭɖɛɘɞɡɟɔɐůŬɛŮ ɛɑŬ əŬŰɖɔɞɟɑŬ 

Ɏɟɗɟɤɜ ɔɘŬ űɖɛɘůɛɏɜŮɠ ˊŬɟŬɚɑŮɠ ůŰɖɜ ˊŮɟɘɞɢɐ Űɞɡ ɝŮɜɞŭɞɢŮɑɞɡ ɛŬɠ Űɖɜ ɞˊɞɑŬ 

ɞɜɞɛɎůŬɛŮ ˊŬɟŬɚɑŮɠ əŬɘ ůɡɛˊŮɟɘɚɎɓŬɛŮ ůŮ ŬɡŰɐɜ Űɘɠ ˊŬɟŬɚɑŮɠ:  

Å ȼ ˊŬɟŬɚɑŬ Űɤɜ ɄŮŰŬɜɩɜ 

Å ȯɛɛŮɠ 

Å ȷɜŰɑůŬɛɞɠ 

Å ɀŬəɟɨɠ əŬɘ ɄɚŬŰɨɠ ũɡŬɚɧɠ 

Å ɀɨɟŰɞɠ 

ũɘŬ Űɖɜ ŮɛűɎɜɘůɖ Űɤɜ Ɏɟɗɟɤɜ ŬɡŰɐɠ Űɖɠ əŬŰɖɔɞɟɑŬɠ ɢɟɖůɘɛɞˊɞɘɐůŬɛŮ Űɞ 

Articles ï Category Module. 

ȷɡŰɧ Űɞ Module ŮɛűŬɜɑɕŮɘ ɛɑŬ ɚɑůŰŬ Ŭˊɧ ɎɟɗɟŬ Ŭˊɧ ɛɑŬ əŬŰɖɔɞɟɑŬ ɖ ˊŮɟɘůůɧŰŮɟŮɠ 

əŬŰɖɔɞɟɑŮɠ. ȷˊɧ Űɞ ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ Joomla ŮˊɘɚɏɔɞɡɛŮ Extensions >  Modules > 

New əŬɘ ůŰɞ Select a Module Type ŮˊɘɚɏɔɞɡɛŮ Articles ï Category. ȹɑɜɞɡɛŮ ɧɜɞɛŬ 

beach_module, ůŰɖɜ Ůˊɘɚɞɔɐ Show Title ŮˊɘɚɏɔɞɡɛŮ Hide. ɆŰɞ ˊŮŭɑɞ Position  

ŮˊɘɚɏɔɞɡɛŮ Űɖɜ ɗɏůɖ right  əŬɘ ŮɚɏɔɢɞɡɛŮ Ůˊɑůɖɠ Űɞ Status ɜŬ ˊŮɟɘɏɢŮɘ Űɖɜ Ůˊɘɚɞɔɐ 

Published. ɆŰɖɜ Ůˊɘɚɞɔɐ Menu Assignment ůŰɞ ˊŮŭɑɞ Module Assignment 

ŮˊɘɚɏɔɞɡɛŮ Only the pages selected əŬɘ ŮˊɘɚɏɔɞɡɛŮ Űɘɠ ɄȷɅɃɉȺɆ. ɆŰɖɜ Ůˊɘɚɞɔɐ 

Filtering Options, ɧˊɤɠ ŭŮɑɢɜŮɘ ɖ ŮɘəɧɜŬ 44, ůŰɞ ˊŮŭɑɞ Count  ŮɘůɎɔɞɡɛŮ Űɖɜ Űɘɛɐ 0, 

ɔɘŬ ɜŬ ŮɛűŬɜɘůŰɞɨɜ ɧɚŬ ŰŬ ɎɟɗɟŬ, ůŰɞ ˊŮŭɑɞ Category ŮˊɘɚɏɔɞɡɛŮ Űɖɜ əŬŰɖɔɞɟɑŬ 

ˊŬɟŬɚɑŮɠ əŬɘ ˊŬŰɎɛŮ Save & Close. 
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ɳʽˁˈ˄ʰ п4  ɲʹ˃ʽˇˎˊʴʾʰ ˁʰʽ ˊˏʻ˃ʽˋʺ ˍˇˎ !ǊǘƛŎƭŜǎ-Category Module 

ɀŮŰɎ Ŭˊɧ ɧɚŬ ŰŬ ˊŬɟŬˊɎɜɤ ɖ ůŮɚɑŭŬ ɄȷɅɃɉȺɆ ɗŬ ɛŬɠ ŮɛűŬɜɘůŰŮɑ ɧˊɤɠ 

ŭŮɑɢɜŮɘ ɖ ŮɘəɧɜŬ 45, ɛŮ ŰŬ 5 ɎɟɗɟŬ Űɖɠ əŬŰɖɔɞɟɑŬɠ Ŭ́ɟŬɚɑŮɠ ůŰŬ ŭŮɝɘɎ Űɞɡ Ɏɟɗɟɞɡ 

ɄŬɟɞɢɏɠ. 

  

 

ɳʽˁˈ˄ʰ п5  ɳ˃˒ʱ˄ʽˋʹ ˍ˖˄ ʱˊʻˊ˖˄ ˋˍʰ ʵʶ˅ʽʱ ˍˇˎ ʱˊʻˊˇˎ ʃʰˊˇ˔ʷˌ 
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4.8.2.   Ʉɟɞůɗɐəɖ ůŰɞɘɢŮɑɞɡ ɛŮɜɞɨ ūɋɇɃũɅȷūȽȺɆ 
 

ɇɩɟŬ ɗŬ ŭɖɛɘɞɡɟɔɐůɞɡɛŮ ɏɜŬ ůŰɞɘɢŮɑɞ ɀŮɜɞɨ ɔɘŬ Űɘɠ űɤŰɞɔɟŬűɑŮɠ ɛŬɠ. 

Ⱥ́ ɘɚɏɔɞɡɛŮ ůŰɞ Menus > Main Menu > Add New Menu Item əŬɘ ŭɖɛɘɞɡɟɔɞɨɛŮ ɏɜŬ 

ůŰɞɘɢŮɑɞ ɀŮɜɞɨ ɛŮ ɧɜɞɛŬ ūɋɇɃũɅȷūȽȺɆ ŮɘəɧɜŬ 46.  

 

ɳʽˁˈ˄ʰ 46  ɲʹ˃ʽˇˎˊʴʾʰ ˍˇˎ ˋˍˇʽ˔ʶʾˇˎ ˃ʶ˄ˇˏ ʊʍʆʁɱʄɮʊɹɳʅ 

ɆŰɞ Menu Item Type * ŮˊɘɚɏɔɞɡɛŮ Űɞ External URL, ůŰɞ ˊŮŭɑɞ Link 

ˊɚɖəŰɟɞɚɞɔɞɨɛŮ Űɞ ˊɚɐəŰɟɞ #, ɔɘŬŰɑ ŭŮɜ ɗɏɚɞɡɛŮ ɜŬ ˊɖɔŬɑɜŮɘ ůŮ Ɏɚɚɖ ůŮɚɑŭŬ, 

ŬɜŰɑɗŮŰŬ ɗɏɚɞɡɛŮ ɧŰŬɜ əɎɜɞɡɛŮ click ɜŬ ɛɖɜ əɎɜŮɘ ŰɑˊɞŰŬ. ȼ Ůˊɘɚɞɔɐ ɛŬɠ ŬɡŰɐ ɏɔɘɜŮ, 

ɔɘŬŰɑ ůŰɞ ůŰɞɘɢŮɑɞ ɛŮ ɧɜɞɛŬ ūɋɇɃũɅȷūȽȺɆ ɗŬ ŭɖɛɘɞɡɟɔɐůɞɡɛŮ ɈˊɞɛŮɜɞɨ ɛŮ 

ůŰɞɘɢŮɑŬ ˊɞɡ ɏɢɞɡɜ ɧɜɞɛŬ ɄȺɅȽɃɉȼɆ, ɂȺɁɃȹɃɉȺȽɃɈ əŬɘ ȹɋɀȷɇȽɃɈ. ɆŰɞ 

ɈˊɞɛŮɜɞɨ ɄȺɅȽɃɉȼɆ ɗŬ ɓɎɚɞɡɛŮ Galleries űɤŰɞɔɟŬűɘɩɜ Ŭˊɧ Űɖɜ ˊŮɟɘɞɢɐ Űɞɡ 

ɝŮɜɞŭɞɢŮɑɞɡ, ůŰɞ ɂȺɁɃȹɃɉȺȽɃɈ Galleries űɤŰɞɔɟŬűɘɩɜ  Ŭˊɧ Űɞ ˊŮɟɘɓɎɚɚɞɜ Űɞɡ 

ɝŮɜɞŭɞɢŮɑɞɡ əŬɘ Űɞɡɠ ŮůɤŰŮɟɘəɞɨɠ Űɞɡ ɢɩɟɞɡɠ əŬɘ ůŰɞ ȹɋɀȷɇȽɃɈ Galleries 

űɤŰɞɔɟŬűɘɩɜ Ŭˊɧ Űɞɡɠ ɢɩɟɞɡɠ Űɤɜ ŭɤɛŬŰɑɤɜ. 

4.8.2.1.   ɈˊɞɛŮɜɞɨ ɄȺɅȽɃɉȼɆ 
 

ũɘŬ Űɞ ůŰɞɘɢŮɑɞ ɈˊɞɛŮɜɞɨ ɄȺɅȽɃɉȼɆ ŭɖɛɘɞɡɟɔɞɨɛŮ ɛɑŬ əŬŰɖɔɞɟɑŬ ɛŮ 

ɧɜɞɛŬ ūɤŰɞɔɟŬűɑŮɠ ˊŮɟɘɞɢɐɠ, ůŰɖɜ ɞˊɞɑŬ űŰɘɎɢɜɞɡɛŮ ɏɜŬ Ɏɟɗɟɞ ɛŮ ɧɜɞɛŬ 

ūɤŰɞɔɟŬűɑŮɠ ˊŮɟɘɞɢɐɠ əŬɘ ɛɏůŬ ůŰɞ Ɏɟɗɟɞ ŮɘůɎɔɞɡɛŮ ɛɑŬ ɗɏůɖ ɛŮ ɧɜɞɛŬ 

photos_area ɧˊɤɠ ɏɢɞɡɛŮ ŬɜŬűɏɟŮɘ ˊŬɟŬˊɎɜɤ ůŮ ɎɟɗɟŬ ɛŮ Galleries əŬɘ ˊŬŰɎɛŮ Save 

& Close. ȾŬŰɧˊɘɜ ŭɖɛɘɞɡɟɔɞɨɛŮ ɏɜŬ űɎəŮɚɞ əɎŰɤ Ŭˊɧ Űɞ images ɛŮ ɧɜɞɛŬ island əŬɘ 
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ɓɎɕɞɡɛŮ ůŮ ŬɡŰɧɜ 12 űɤŰɞɔɟŬűɑŮɠ Űɘɠ ˊŮɟɘɞɢɐɠ Űɞɡ ɝŮɜɞŭɞɢŮɑɞɡ ɛŬɠ Űɘɠ ɞˊɞɑŮɠ 

ɗɏɚɞɡɛŮ ɜŬ ŮɛűŬɜɑɕŮɘ ɖ ůŮɚɑŭŬ ɛŬɠ ůŮ 4 ɔɟŬɛɛɏɠ əŬɘ 3 ůŰɐɚŮɠ. 

ȰˊŮɘŰŬ ůŰɞ ŭɘŬɢŮɘɟɘůŰɘəɧ Űɞɡ Joomla ŮˊɘɚɏɔɞɡɛŮ Menus > Main Menu > Add 

New Menu Item  ŭɖɛɘɞɡɟɔɞɨɛŮ ɏɜŬ ɜɏɞ ůŰɞɘɢŮɑɞ ɛŮɜɞɨ ɛŮ ɧɜɞɛŬ ɄȺɅȽɃɉȼɆ. ɆŰɞ 

Menu Item Type *  ŮˊɘɚɏɔɞɡɛŮ Űɞ Single Article (Ŭˊɚɧ Ɏɟɗɟɞ) , ůŰɞ Select Articles 

ŮˊɘɚɏɔɞɡɛŮ Űɞ Ɏɟɗɟɞ ūɤŰɞɔɟŬűɑŮɠ ˊŮɟɘɞɢɐɠ, ůŰɞ Parent Item  ŮˊɘɚɏɔɞɡɛŮ Űɞ ůŰɞɘɢŮɑɞ 

ɛŮɜɞɨ ūɋɇɃũɅȷūȽȺɆ, ˊɞɡ ůɖɛŬɑɜŮɘ ɧŰɘ Űɞ ůŰɞɘɢŮɑɞ ɈˊɞɛŮɜɞɨ ɄȺɅȽɃɉȼɆ ɗŬ ɏɢŮɘ 

ɔɞɜɘəɧ ůŰɞɘɢŮɑɞ Űɞ ůŰɞɘɢŮɑɞ ɛŮɜɞɨ ūɋɇɃũɅȷūȽȺɆ əŬɘ ˊŬŰɎɛŮ Save & Close.   

ȷəɞɚɞɨɗɤɠ ŭɖɛɘɞɡɟɔɞɨɛŮ ɏɜŬ Image Gallery Module ɛŮ Űɞɜ Űɟɧˊɞ ˊɞɡ 

ɏɢɞɡɛŮ ˊɟɞŬɜŬűɏɟŮɘ ɛŮ ɧɜɞɛŬ fotos_area  ɧˊɤɠ ŭŮɑɢɜŮɘ ɖ ŮɘəɧɜŬ 47. 

 

ɳʽˁˈ˄ʰ п7  ɲʹ˃ʽˇˎˊʴʾʰ Image Gallery Module ˃ ʶ ˈ˄ˇ˃ʰ fotos_area ɹ ʽʰ ˍˇ ʱˊʻˊˇ ʊ˖ˍˇʴˊʰ˒ʾʶˌ 

ˉʶˊʽˇ˔ʺˌ 

ɆŰɞ ˊŮŭɑɞ Show Title ŮˊɘɚɏɔɞɡɛŮ Hide, ůŰɞ Images folder ɗŬ ɓɎɚɞɡɛŮ Űɞ 

images/island, ůŰŬ ˊŮŭɑŬ Rows əŬɘ Columns ɗŬ ɓɎɚɞɡɛŮ Űɘɠ Űɘɛɏɠ 4 əŬɘ 3 ŬɜŰɑůŰɞɘɢŬ, 

ůŰŬ ˊŮŭɑŬ Preview image width əŬɘ Preview image height ɗŬ ɓɎɚɞɡɛŮ Űɘɠ Űɘɛɏɠ 300 

əŬɘ 250 ŬɜŰɑůŰɞɘɢŬ əŬɘ ůŰɞ ˊŮŭɑɞ Position ŮˊɘɚɏɔɞɡɛŮ Űɖɜ ɗɏůɖ  photos_area .  ɆŰɖɜ 

Ůˊɘɚɞɔɐ Menu Assignment ůŰɞ Module Assignment ŮˊɘɚɏɔɞɡɛŮ Only the pages 

selected, ŮˊɘɚɏɔɞɡɛŮ ɜŬ ŮɛűŬɜɑɕŮŰŬɘ ɛɧɜɞ ůŰɞ ůŰɞɘɢŮɑɞ ɡˊɞɛŮɜɞɨ ɄȺɅȽɃɉȼɆ Űɞɡ 

Main Menu əŬɘ ˊŬŰɎɛŮ Save & Close. ɇɞ ŬˊɞŰɏɚŮůɛŬ Űɤɜ ˊŬɟŬˊɎɜɤ ŮɜŮɟɔŮɘɩɜ 

űŬɑɜŮŰŬɘ ůŰɖɜ ŮɘəɧɜŬ 48 Űɖɠ ůŮɚɑŭŬɠ ūɋɇɃũɅȷūȽȺɆ/ ɄȺɅȽɃɉȼɆ. 
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ɳʽˁˈ˄ʰ 48 ɳ˃˒ʱ˄ʽˋʹ ̱ ˇˎ Image Gallery Module fotos_area ̀  ʁrows 4 ˁ ʰʽ columns 3 ̀ ˍʹ˄ ˁʶ˄ˍˊʽˁʺ 

ˋʶ˂ʾʵʰ 

 

4.8.2.2.   ɈˊɞɛŮɜɞɨ ɂȺɁɃȹɃɉȺȽɃɈ 

ȳˊɤɠ űŰɘɎɝŬɛŮ Űɞ ˊɟɞɖɔɞɨɛŮɜɞ ɡˊɞɛŮɜɞɨ ɄȺɅȽɃɉȼɆ ŰŬ ɑŭɘŬ Ŭəɟɘɓɩɠ 

ɓɐɛŬŰŬ əɎɜɞɡɛŮ ɔɘŬ ɜŬ ŭɖɛɘɞɡɟɔɐůɞɡɛŮ Űɞ ɡˊɞɛŮɜɞɨ ɂȺɁɃȹɃɉȺȽɃɈ əŬɘ 

ȹɋɀȷɇȽɋɁ ˊɞɡ ɗŬ ŬəɞɚɞɡɗɐůŮɘ. 

ɄɟɩŰŬ ŭɖɛɘɞɡɟɔɞɨɛŮ ɛɑŬ əŬŰɖɔɞɟɑŬ ɛŮ ɧɜɞɛŬ ūɤŰɞɔɟŬűɑŮɠ ɝŮɜɞŭɞɢŮɑɞɡ, 

ůŰɖɜ ɞˊɞɑŬ ŭɖɛɘɞɡɟɔɞɨɛŮ ɏɜŬ Ɏɟɗɟɞ ɛŮ ɧɜɞɛŬ ūɤŰɞɔɟŬűɑŮɠ ɝŮɜɞŭɞɢŮɑɞɡ əŬɘ ɛɏůŬ 

ůŰɞ Ɏɟɗɟɞ ŮɘůɎɔɞɡɛŮ ɛɑŬ ɗɏůɖ ɛŮ ɧɜɞɛŬ photos_hotel ɧˊɤɠ ɏɢɞɡɛŮ ŬɜŬűɏɟŮɘ 

ˊŬɟŬˊɎɜɤ ůŮ ɎɟɗɟŬ ɛŮ Galleries əŬɘ ˊŬŰɎɛŮ Save & Close. ȾŬŰɧˊɘɜ ŭɖɛɘɞɡɟɔɞɨɛŮ 

ɏɜŬ űɎəŮɚɞ əɎŰɤ Ŭˊɧ Űɞ images ɛŮ ɧɜɞɛŬ fotos_hotel əŬɘ ɓɎɕɞɡɛŮ ůŮ ŬɡŰɧɜ 12 

űɤŰɞɔɟŬűɑŮɠ Űɞɡ ɝŮɜɞŭɞɢŮɑɞɡ ɛŬɠ Űɘɠ ɞˊɞɑŮɠ ɗɏɚɞɡɛŮ ɜŬ ŮɛűŬɜɑɕŮɘ ɖ ůŮɚɑŭŬ ɛŬɠ ůŮ 4 

ɔɟŬɛɛɏɠ əŬɘ 3 ůŰɐɚŮɠ . 

ȰˊŮɘŰŬ ŭɖɛɘɞɡɟɔɞɨɛŮ ɏɜŬ ɜɏɞ ůŰɞɘɢŮɑɞ ɛŮɜɞɨ ɛŮ ɧɜɞɛŬ ɂȺɁɃȹɃɉȺȽɃɈ. 

ɆŰɞ Menu Item Type * ŮˊɘɚɏɔɞɡɛŮ Űɞ Single Article (Ŭˊɚɧ Ɏɟɗɟɞ) ,ůŰɞ Select 

Articles ŮˊɘɚɏɔɞɡɛŮ Űɞ Ɏɟɗɟɞ ūɤŰɞɔɟŬűɑŮɠ ɝŮɜɞŭɞɢŮɑɞɡ, ůŰɞ Parent Item ŮˊɘɚɏɔɞɡɛŮ 

Űɞ ůŰɞɘɢŮɑɞ ɛŮɜɞɨ ūɋɇɃũɅȷūȽȺɆ, ˊɞɡ ůɖɛŬɑɜŮɘ ɧŰɘ Űɞ ůŰɞɘɢŮɑɞ ɡˊɞɛŮɜɞɨ 


